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บทคดัย่อ 
(Abstract) 

 
โครงงานนี้เป็นการศึกษาโครงสร้างของระบบตรวจวัดอุณหภูมิอัตโนมัติโดยผ่านเครือข่าย  

xbee วัดอุณหภูมิโดยมีแหล่งจ่ายเป็นโซล่าเซลล์โดยเป็นการประยุกต์บอร์ดไมโครคอนโทรเลอร์ 
Arduino UNO R3 กับ sensor วัดอุณหภูมิ DS18B20 โดยใช้ภาษา C เป็นตัวสั่งการ โดยที่จะมีการ
ใช้งาน 2 ระบบ คือจากภาคส่งและภาครับ โดยที่ภาคส่งจะท าการวัดอุณหภูมิโดยใช้วงจรเซนเซอร์ต่อ
กับบอร์ด arduino Uno R3 และใช้การส่งไร้สายจาก xbee และใช้แหล่งจ่ายจากโซล่าเซลล์ และส่ง
ค่าข้อมูลเซนเซอร์ไปให้ภาครับ โดยที่ภาครับก็รับค่าจากการส่งไร้สายจาก Xbee ที่ต่อกับ arduino
ด้วยเช่นกัน จากนั้นจะแสดงผลค่าอุณหภูมิที่จอ LCD และถ้าอุณหภูมิเกินค่าที่เราได้ก าหนดไว้ จะเกิด
การแจ้งเตือนของวงจรเสียง จากการทดสอบพบว่าปัจจุบันการใช้พลังงานไฟฟ้ามีมากขึ้น ท าให้
สิ้นเปลืองพลังงาน จึงได้พลังงานทดแทนจากโซล่าเซลล์ เพ่ือท าให้ไม่มีการสิ้นเปลืองพลังงาน เพราะ
พลังงานจากโซล่าเซลล์สามารถชาร์จเข้าแบตเตอรี่ได้ และท าให้วงจรภาคส่งสามารถท างานตลอดเวลา 
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ตลอด จนกระทั่งโครงงานนี้ส าเร็จลุล่วงไปด้วยดี 
 คณะผู้จัดท าโครงงานใคร่ขอกราบขอบพระคุณทุกๆ ท่านที่ได้กล่าวไปแล้วไว้ ณ ที่นี้ ส าหรับ
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ผู้จัดท าโครงงาน หากโครงงานชิ้นดีมีข้อผิดพลาดประการใดทางคณะผู้จัดท าโครงงานใคร่ขอน้อมรับ
และขออภัยมา ณ ที่นี้ 
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บทที่1 
บทน า 

 
1.1บทน า 

ระบบเครือข่ายท้องถิ่นไร้สายในปัจจุบันนี้ก าลังได้รับความนิยมอย่างมากในการน ามาใช้งาน 
เนื่องจากมีความสะดวก แต่ยังคงมีปัญหาในหลายๆเรื่อง เช่น ระยะทางในการส่ง สิ่งกีดขวางต่างๆ 
และในระบบตรวจวัดอุณหภูมิอัตโนมัติโดนผ่านเครือข่าย xbee ที่ใช้แหล่งจ่ายโซลล่าเซลล์ นั้นเป็น
การติดสื่อสารในระยะทางสั้นๆ โดยติดต่อสื่อสารผ่าน xbee และยังมีการพัฒนาแหล่งจ่ายพลังงานที่
ใช้ในภาคส่ง โดยการน า โซลล่าเซลล์ เข้ามาช่วยในการประหยัดพลังงานและสามารถประหยัดค่าใช้ได้
พอสมควร และยังเป็นการวางแผนการใช้พลังงานในระยะยาว เนื่องภาคส่งเราใช้พลังงานน้อย จึงท า
ให้เหมาะส าหรับการใช้พลังงานโซลล่าเซลล์ ได้อย่างเหมาะสมและโซลล่าเซลล์ก็สามารถผลิตพลังงาน
ได้อย่างเพียงพอกับความต้องการในการงานของภาคส่ง ถึงแม้ว่าบางทีอาจจะเกิดปัญหาฝนตก ไม่มี
แดด แตย่ังก็น าแบตเตอรี่มาใช้ในการเก็บพลังงานส ารองไว้ใช้ ในกรณีฉุกเฉินได้ 

 
1.2 หลกัการและเหตผุล 

การท างานของ XBee จะเป็นการรับ-ส่งคลื่นสัญญาณข้อมูล ผ่านชิปเล็กจุดต่อจุดไปเรื่อยๆ 
จนถึงปลายทางที่ต้องการดาวน์โหลดข้อมูลลงในเครื่องคอมพิวเตอร์เพ่ือใช้ในการวิเคราะห์ข้อมูข้อมูล
ที่ได้อาจจะเป็นการวัดอุณหภูมิ การเคลื่อนไหวของสิ่งมีชีวิต เป็นต้น ในที่นี้เราใช้ในการวัดอุณหภูมิ 
โดยที่เหล่งจ่ายที่ใช้ในการส่งใช้พลังงานจากโซล่าเซลล์ ซึ่งการท างานของโซล่าเซลล์ เป็นขบวนการ
เปลี่ยนพลังงานแสงเป็นกระแสไฟฟ้าได้โดยตรง โดยเมื่อแสงซึ่งเป็นคลื่นแม่เหล็กไฟฟ้าและมีพลังงาน
กระทบกับสารกึ่งตัวน า จะเกิดการถ่ายทอดพลังงานระหว่างกัน พลังงานจากแสงจะท าให้เกิดการ
เคลื่อนที่ของกระแสไฟฟ้า (อิเลคตรอน) ขึ้นในสารกึ่งตัวน า จึงสามารถต่อกระแสไฟฟ้าดังกล่าวไปใช้
งานได้ นอกจากนี้ผู้ใช้งานต้องรู้จักโปรแกรม X-CTU เพ่ือใช้การปรับพารามิเตอร์ของ Xbee ใน
ปัจจุบันการส่งข้อมูลโดยใช้บอร์ด ไมโครคอนโทรลเลอร์ ใช้ไฟจาก adapter ซึ่งถ้าท างานบอร์ด 
ไมโครคอนโทรลเลอร์ ทั้งวันจะเป็นการสูญเสียพลังงานไฟฟ้ามากเกินไป จากการเล็ งเห็นปัญหา
ดังกล่าวมาแล้วข้างต้นผู้เสนอโครงงานมีความสนใจที่จะพัฒนาให้ใช้พลังงานจากพลังงานแสงอาทิตย์ 
โดยที่ เ วลาที่ ไม่มีแสงอาทิตย์  เราสามารถใช้พลั ง งานจากแบตเตอรี่ ได้ มาควบคุมบอร์ด 
ไมโครคอนโทรลเลอร์ 
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รูปที่ 1 โครงสร้างโดยรวม 
 

       ดังรูปที ่ 1 แสดงผังไดอะแกรมระบบตรวจวัดอุณหภูมิโดยผ่านเครือข่าย zigbee ที่ใช้แหล่งจ่าย
จากโซล่าเซลล์ โดยใช้การควบคุมการส่งและการรับด้วยบอร์ดไมโครคอนโทรลเลอร์ (arduino Uno ) 
ภาครับจะมีวงจรแจ้งเตือน (alarm) แล้วจะรับข้อมูลไปแสดงผลที่จอ LCD ขนาด 16 ตัวอักษร 2 
บรรทัด 
 
1.3 วตัถปุระสงค ์

1. เพ่ือศึกษาการใช้งานของ บอร์ดไมโครคอนโทรลเลอร์ (arduino) 
2. เพ่ือศึกษาการใช้โปรแกรม X-ctu 
3. เพ่ือศึกษาการใช้ไฟฟ้าจากพลังงานแสงอาทิตย์ 
4. เพ่ือสามารถใช้โปรแกรม Arduino IDE บนพื้นฐานภาษา C มาควบคุมการท างานของ

บอร์ดไมโครคอนโทรลเลอร์ Arduino และ Sensor ได้ 
5. เพ่ือพัฒนาระบบตรวจจับวัดอุณหภูมิที่มีต้นทุนถูกกว่าท้องตลาดได้ 
6. เพ่ือฝึกการท างานเป็นทีม การแก้ปัญหาต่างๆที่เกิดข้ึน 

 
1.4 ขอบเขตงาน 

1. ศึกษาโปรแกรม X-CTU เพ่ือใช้ในการ set ค่าพารามิเตอร์ต่างๆของ xbee 
2. ศึกษาโปรแกรม Circuit Wizard  เพ่ือใช้ในการออกแบบวงจรต่างๆ 
3. ศึกษาการใช้งาน arduino เพ่ือใช้ในการเขียนค าสั่งควบคุมต่างๆ 
4. สร้างอุปกรณ์ท่ีจะใช้ในการทดสอบทั้งภาครับและภาคส่ง 
5. น าอุปกรณ์ท้ังหมดมาประกอบรวมกัน 
6. ทดสอบชิ้นงานที่ท าตามวัตถุประสงค์ 

Arduino กบั Xbee Arduino กบั Xbee 

LCD 

Sensor 

Solar cell กบั battery 
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1.5 ขัน้ตอนการด าเนนิงาน 
 

1. ศึกษาค้นคว้าข้อมูล 
2. เขียนโครงการและเสนอโครงงานกับอาจารย์ที่ปรึกษา 
3. ศึกษาเกี่ยวกับไมโครคอนโทรลเลอร์ Arduino UNO R3 และ เซนเซอร์วัดอุณหภูมิ 

DS18B20 
4. ศึกษาโปรแกรม x-ctu และโปรแกรม circuit wizard 
5. เตรียมการซื้ออุปกรณ์ 
6. เชื่อมการท างานของเซนเซอร์วัดอุณหภูมิ DS18B20 และบอร์ดไมโครคอนโทรลเลอร์ 

Arduino UNO R3 ด้วยโปรแกรม Arduino IDE บนพื้นฐานภาษา C 
7. ท าการทดลองวิเคราะห์การทดลองและสรุปผลการทดลอง 
8. น าเสนอโครงงาน 

 
1.6 ผลทีค่าดวา่จะไดร้บั 
 

1. สามารถน าความรู้ทางทฤษฎีที่ศึกษาน ามาประยุกต์ใช้ในทางปฎิบัติ 
2. สามารถน าความรู้มาใช้ในการประกอบวิชาชีพได้ 
3. สามารถแก้ปัญหาที่เกิดข้ึนจากการท างานได้ 
4. รู้จักการท างานเป็นทีม 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

บทที ่ 2 
หลกัการและทฤษฎทีี่เกีย่วขอ้ง 

 
2.1   บทน า 
 เนื้อหาในบทนี้จะกล่าวถึงหลักการ แนวคิดและทฤษฎีที่เกี่ยวข้องกับระบบตรวจวัดอุณหภูมิ
อัตโนมัติโดยผ่านเครือข่าย xbee วัดอุณหภูมิโดยมีแหล่งจ่ายเป็นโซล่าเซลล์โดยเริ่มตั้งแต่ความรู้
เบื้องต้นและคุณสมบัติของความอุณหภูมิ ตลอดจนเครื่องมือ อุปกรณ์และวิธีการท าเครื่องมือตรวจวัด
อุณหภูมิที่สามารถใช้ได้ เพ่ือน ามาศึกษาเป็นแนวทางไปสู่การพัฒนาระบบตรวจวัดอุณหภูมิอัตโนมัติ
โดยผ่านเครือข่าย xbee วัดอุณหภูมิโดยมีแหล่งจ่ายเป็นโซล่าเซลล์ 
 
2.2   ความร้อน และอุณหภูมิ  
 เชื้อเพลิงเปลี่ยนรูปเป็นพลังงานความร้อนในเครื่องยนต์ จากนั้นก็แปรเปลี่ยนเป็นพลังงานกล
ท าให้พลังงาน (energy) หมายถึง ความสามารถในการท างาน ตัวอย่างเช่น พลังงานเคมีจากน้ า
เชื้อเพลิง ท าให้รถยนต์เคลื่อนที่ พลังงานมีหลายรูปแบบ พลังงานสามารถเปลี่ยนจากรูปหนึ่งไปสู่อีก
รูปหนึ่งเช่นพลังงานเคมีจากน้ ารถยนต์เคลื่อนที่  
แบ่งพลังงานออกเป็น2ประเภทคือ  
           พลังงานศักย์ (Potential energy) หมายถึง ศักยภาพที่จะท าให้เกิดงาน ซึ่งมีอยู่ในวัตถุท่ี
หยุดนิ่งเช่นเชื้อเพลิงอาหาร 
           พลังงานจลน์ (Kinetic energy) หมายถึง พลังงานซึ่งเกิดจากการเคลื่อนที่ ตัวอย่างเช่น 
เมื่อใช้ค้อนตอกตะปู ค้อนท าให้เกิดพลังงานจลน์ดันตะปูให้เคลื่อนที่ ยิ่งค้อนมีมวลมาก และมีความเร็ว
สูง พลังงานจลน์ก็ยิ่งมาก 
ความร้อนและอณุหภูม ิ
          สสารทั้งหลายประกอบด้วย อะตอมรวมตัวกันเป็นโมเลกุล การเคลื่อนที่ของอะตอม หรือการ
สั่นของโมเลกุล ท าให้เกิดรูปแบบของพลังงานจลน์ ซึ่งเรียกว่า “ความร้อน” (Heat) พิจารณาพลังงาน
ความร้อน (Heat energy) จากพลังงานทั้งหมดท่ีเกิดขึ้นจากการเคลื่อนที่ของอะตอมหรือโมเลกุล
ทั้งหมดของสสาร  
          อุณหภูมิ (Temperature) หมายถึง การวัดค่าเฉลี่ยของพลังงาานจลน์ซึ่งเกิดข้ึนจากอะตอม
แต่ละตัว หรือแต่ละโมเลกุลของสสาร เมื่อใส่พลังงานความร้อนให้กับสสาร อะตอมของจะเคลื่อนที่เร็ว
ขึ้น ท าให้อุณหภูมิสูงขึ้น แต่เมื่อลดพลังงานความร้อน อะตอมของสสารจะเคลื่อนที่ช้าลงท าให้
อุณหภูมิลดต่ าลง  
          หากต้มน้ าด้วยถ้วยและหม้อบนเตาเดียวกัน  จะเห็นได้ว่าน้ าในถ้วยจะมีอุณหภูมิสูงกว่า แต่จะ
มีพลังงานความร้อนน้อยกว่าในหม้อ เนื่องจากปริมาณความร้อนขึ้นอยู่กับมวลทั้งหมดของสสาร แต่
อุณหภูมิเป็นเพียงค่าเฉลี่ยของพลังงานในแต่ละอะตอม ดังนั้นบรรยากาศชั้นบนของโลก (ชั้นเทอร์โมส
เฟียร์) จึงมีอุณหภูมิสูง แต่มีพลังงานความร้อนน้อย เนื่องจากมีมวลอากาศอยู่อย่างเบาบาง 
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สเกลอุณหภมู ิ
           องศาฟาเรนไฮต์ 
            ในปี ค.ศ.1714 กาเบรียล ฟาเรนไฮต์ (Gabrial Fahrenheit) นักฟิสิกส์ชาวเยอรได้ประดิษฐ์
เทอร์มอมิเตอร์ซึ่งบรรจุปรอทไว้ในหลอดแก้ว พยายามท าให้ปรอทลดต่ าสุด (0°F) โดยใช้น้ าแข็งและ
เกลือผสมน้ า พิจารณาจุดหลอมละลายของน้ าแข็งเท่ากับ 32°F และจุดเดือดของน้ าเท่ากับ212°F 
           องศาเซลเซียส 
            ในปี ค.ศ.1742 แอนเดอส์ เซลเซียส (Anders Celsius) นักดาราศาสตร์ชาวสวีเดน ได้
ออกแบบสเกลเทอร์มอมิเตอร์ให้อ่านได้ง่ายขึ้น โดยมีจุดหลอมละลายของน้ าแข็งเท่ากับ 0°C และจุด
เดือดของน้ าเท่ากับ100°C 
           เคลวิน(องศาสัมบูรณ์)  
            ต่อมาในคริสศตวรรษท่ี 19 ลอร์ด เคลวิน (Lord Kelvin) นักฟิสิกส์ชาวอังกฤษ ผู้ค้นพบ
ความสัมพันธ์ระหว่างความร้อนและอุณหภูมิว่า ณ อุณหภูมิ -273°C อะตอมของสสารจะไม่มีการ
เคลื่อนที่ และจะไม่มีสิ่งใดหนาวเย็นไปกว่านี้ได้อีก จึงก าหนดให้ 0 K = -273°C (ไม่ต้องใช้เครื่องหมาย 
° ก ากับหน้าอักษร K) สเกลองศาสัมบูรณ์หรือเคลวิน เช่นเดียวกับองศาเซลเซียสทุกประการ เพียงแต่ 
+273 เข้าไป เมื่อต้องการเปลี่ยนเคลวินเป็นเซลเซียส ดังรูปที่ 2.1 
 

 
รูปที่ 2.1 เปรียบเทียบสเกลอุณหภูมิทั้ง 3 ระบบ 
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ความสัมพันธ์ของสเกลอุณหภูมิ 
ระยะสเกลฟาเรนไฮต์ = 212 °F – 32 °F = 180 °F 
ระยะสเกลเซลเซียส = 100 °C – 0 °C = 100 °C 
สเกลทั้งสองมีความแตกต่างกัน = 180/100 = 1.8 

ความสัมพันธ์ของสเกลทั้งสองจึงเป็นดังนี้ 
°F = (1.8 X °C) + 32 
°C = (°F -32) / 1.8 

 
ตวัอยา่ง: อุณหภูมิของร่างกายมนุษย์ 98.6°F คิดเป็นองศาเซลเซียสและเคลวินได้เท่าไร 
   แปลงเป็นองศาเซลเซียส=(°F-32)/1.8 
                              =(98.6-32)/1.8  
                              =37°C 
   แปลงเป็นองศาสัมบูรณ์=37+273K  
                              = 310 K 
 
2.3   โซล่าเซลล ์
 โซล่าเซลล์เป็นสิ่งประดิษฐ์กรรมทางอิเลคทรอนิกส์ ที่สร้างขึ้นเพ่ือเป็นอุปกรณ์ส าหรับเปลี่ยน
พลังงานแสงอาทิตย์ให้เป็นพลังงานไฟฟ้า โดยการน าสารกึ่งตัวน า เช่น ซิลิกอน ซึ่งมีราคาถูกที่สุดและ
มีมากท่ีสุดบนพื้นโลกมาผ่านกระบวนการทางวิทยาศาสตร์เพื่อผลิตให้เป็นแผ่นบางบริสุทธิ์ และทันทีที่
แสงตกกระทบบนแผ่นเซลล์ รังสีของแสงที่มีอนุภาคของพลังงานประกอบที่เรียกว่า โฟตอน (Proton) 
จะถ่ายเทพลังงานให้กับอิเล็กตรอน (Electron) ในสารกึ่งตัวน าจนมีพลังงานมากพอที่จะกระโดด
ออกมาจากแรงดึงดูดของอะตอม (atom) และเคลื่อนที่ได้อย่างอิสระ ดังนั้นเมื่ออิเล็กตรอนเคลื่อนที่
ครบวงจรจะท าให้เกิดไฟฟ้ากระแสตรงขึ้น เมื่อพิจารณาลักษณะการผลิตไฟฟ้าจากโซล่าเซลล์พบว่า โซ
ล่าเซลล์จะมีประสิทธิภาพการผลิตไฟฟ้าสูงที่สุดในช่วงเวลากลางวัน ซึ่งสอดคล้องและเหมาะสมในการ
น าโซล่าเซลล์มาใช้ผลิตไฟฟ้า เพ่ือแก้ไขปัญหาการขาดแคลนพลังงานไฟฟ้าในช่วงเวลากลางวัน 
 
2.3.1 ประวตัคิวามเปน็มาของโซล่าเซลล ์

โซล่าเซลล์ถูกสร้างข้ึนมาครั้งแรกในปี ค.ศ. 1954 (พ.ศ. 2497) โดย แชปปิน (Chapin) ฟูล
เลอร์ (Fuller) และเพียสัน (Pearson) แห่งเบลล์เทลเลโฟน (Bell Telephon) โดยทั้ง 3 นี้ได้ค้นพบ
เทคโนโลยีการสร้างรอยต่อ พี-เอ็น (P-N) แบบใหม่ โดยวิธีการแพร่สารเข้าไปในผลึกของซิลิกอน จนได้
โซล่าเซลล์อันแรกของโลก ซึ่งมีประสิทธิภาพเพียง 6% ซึ่งปัจจุบันนี้โซล่าเซลล์ได้ถูกพัฒนาขึ้นจนมี
ประสิทธิภาพสูงกว่า 15% แล้ว ในระยะแรกโซล่าเซลล์ส่วนใหญ่จะใช้ส าหรับโครงการด้านอวกาศ 
ดาวเทียมหรือยานอวกาศท่ีส่งจากพ้ืนโลกไปโคจรในอวกาศ ก็ใช้แผงโซล่าเซลล์เป็นแหล่งก าเนิดพลัง
ไฟฟ้า ต่อมาจึงได้มีการน าเอาแผงโซล่าเซลล์มาใช้บนพื้นโลกเช่นในปัจจุบันนี้ โซล่าเซลล์ในยุคแรกๆ 
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ส่วนใหญ่จะมีสีเทาด า แต่ในปัจจุบันนี้ได้มีการพัฒนาให้โซล่าเซลล์มีสีต่างๆ กันไป เช่น แดง น้ าเงิน 
เขียว ทอง เป็นต้น เพ่ือความสวยงาม 
 
2.3.2 ชนดิของโซลา่เซลล ์
แบ่งตามวัสดุที่ใช้เป็น 3 ชนิดหลักๆ คือ 

1.โซล่าเซลล์ที่ท าจากซิลิคอน ชนิดผลึกเดี่ยว (Single Crystalline Silicon Solar Cell) หรือ
ที่รู้จักกันในชื่อ MonocrystallineSilicon Solar Cell และชนิดผลึกรวม (Polycrystalline Silicon 
Solar Cell) ลักษณะเป็นแผ่นซิลิคอนแข็งและบางมาก 

 
รูปที่ 2.2 Single Crystalline Silicon Solar Cell 

2. โซล่าเซลล์ที่ท าจากอะมอร์ฟัสซิลิคอน (Amorphous Silicon Solar Cell) ลักษณะเป็น
ฟิล์มบางเพียง 0.5 ไมครอน (0.0005 มม.) น้ าหนักเบามาก และประสิทธิภาพเพียง 5-10% 

 
รูปที่ 2.3 Polycrystalline Silicon Solar Cell 
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3. โซล่าเซลล์ที่ท าจากสารกึ่งตัวน าอื่นๆ เช่น แกลเลี่ยม อาร์เซไนด์, แคดเมียม เทลเลอไรด์ 
และคอปเปอร์ อินเดียม ไดเซเลไนด์ เป็นต้น มีทั้งชนิดผลึกเดี่ยว (Single Crystalline) และผลึกรวม 
(Polycrystalline) โซล่าเซลล์ที่ท าจากแกลเลี่ยม อาร์เซไนด์ จะให้ประสิทธิภาพสูงถึง 20-25% 

 
รูปที่ 2.4 Amorphous Silicon Solar Cell 

 
2.3.3 หลกัการท างานทั่วไปของโซลา่เซลล ์

 
รูปที่ 2.5 หลักการท างานทั่วไป 

เมื่อมีแสงอาทิตย์ตกกระทบโซล่าเซลล์ จะเกิดการสร้างพาหะน าไฟฟ้าประจุลบและบวกข้ึน 
ได้แก่ อิเล็กตรอนและ โฮล โครงสร้างรอยต่อพีเอ็นจะท าหน้าที่สร้างสนามไฟฟ้าภายในเซลล์ เพ่ือแยก
พาหะน าไฟฟ้าชนิดอิเล็กตรอนไปท่ีขั้วลบ และพาหะน าไฟฟ้าชนิดโฮลไปที่ข้ัวบวก (ปกติท่ีฐานจะใช้
สารกึ่งตัวน าชนิดพี ขั้วไฟฟ้าด้านหลังจึงเป็นขั้วบวก ส่วนด้านรับแสงใช้สารกึ่งตัวน าชนิดเอ็น ขั้วไฟฟ้า
จึงเป็นขั้วลบ) ท าให้เกิดแรงดันไฟฟ้าแบบกระแสตรงที่ขั้วไฟฟ้าทั้งสอง เมื่อต่อให้ครบวงจรไฟฟ้าจะเกิด
กระแสไฟฟ้าไหลขึ้น 
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2.3.4 ลกัษณะเด่นของโซลา่เซลล ์
1.ใช้พลังงานจากธรรมชาติ คือ แสงอาทิตย์ ซึ่งสะอาดและบริสุทธิ์ ไม่ก่อปฏิกิริยาที่จะท าให้
สิ่งแวดล้อมเป็นพิษ 
2.  เป็นการน าพลังงานจากแหล่งธรรมชาติมาใช้อย่างคุ้มค่าและไม่มีวันหมดไปจากโลกนี้ 
3.สามารถน าไปใช้เพื่อผลิตพลังงานไฟฟ้าได้ทุกพ้ืนที่บนโลก และได้พลังงานไฟฟ้าใช้โดยตรง 
4.ไม่ต้องใช้เชื้อเพลิงอ่ืนใดนอกจากแสงอาทิตย์ รวมถึงไม่มีการเผาไหม้ จึงไม่ก่อให้เกิด
มลภาวะด้านอากาศและน้ า 
5.ไม่เกิดของเสียขณะใช้งาน จึงไม่มีการปล่อยมลพิษท าลายสิ่งแวดล้อม 
6. ไม่เกิดเสียงและไม่มีการเคลื่อนไหวขณะใช้งาน จึงไม่เกิดมลภาวะด้านเสียง 
7.เป็นอุปกรณ์ที่ติดตั้งอยู่กับท่ี และไม่มีชิ้นส่วนใดที่มีการเคลื่อนไหวขณะท างาน จึงไม่เกิดการ
สึกหรอ 
8.ต้องการการบ ารุงรักษาน้อยมาก 
9. อายุการใช้งานยืนยาวและประสิทธิภาพคงที่ 
10. มีน้ าหนักเบา ติดตั้งง่าย เคลื่อนย้ายสะดวกและรวดเร็ว 
11.เนื่องจากมีลักษณะเป็นโมดูล จึงสามารถประกอบได้ตามขนาดที่ต้องการ 
12.ช่วยลดปัญหาการสะสมของก๊าซต่างๆ ในบรรยากาศ เช่น คาร์บอนมอนอกไซด์ , ซัลเฟอร์
ไดออกไซด,์ ไฮโดรคาร์บอน และก๊าซไนโตรเจนออกไซด์ ฯลฯ ซึ่งเป็นผลจากการเผาไหม้ของ
เชื้อเพลิงจ าพวกน้ า ถ่านหิน และก๊าซธรรมชาติ ล้วนแล้วแต่ส่งผลกระทบต่อสิ่งแวดล้อม 
เกิดปฏิกิริยาเรือนกระจก ท าให้โลกร้อนข้ึน เกิดฝนกรด และอากาศเป็นพิษ ฯลฯ 

 
2.3.5 คุณสมบัตแิละตวัแปรทีส่ าคญัของโซลา่เซลล ์

ตัวแปรที่ส าคัญที่มีส่วนท าให้โซล่าเซลล์มีประสิทธิภาพการท างานในแต่ละพ้ืนที่ต่างกัน และมี
ความส าคัญในการพิจารณาน าไปใช้ในแต่ละพ้ืนที่ ตลอดจนการน าไปค านวณระบบหรือค านวณ
จ านวนแผงแสงอาทิตย์ที่ต้องใช้ในแต่ละพ้ืนที่ มีดังนี้ 
ความเขม้ของแสง 

กระแสไฟ (Current) จะเป็นสัดส่วนโดยตรงกับความเข้มของแสง หมายความว่าเมื่อความ
เข้มของแสงสูง กระแสที่ได้จากโซล่าเซลล์ก็จะสูงขึน้ ในขณะที่แรงดันไฟฟ้าหรือโวลต์แทบจะไม่แปรไป
ตามความเข้มของแสงมากนัก ความเข้มของแสงที่ใช้วัดเป็นมาตรฐานคือ ความเข้มของแสงที่วัดบน
พ้ืนโลกในสภาพอากาศปลอดโปร่ง ปราศจากเมฆหมอกและวัดที่ระดับน้ าทะเลในสภาพที่แสงอาทิตย์
ตั้งฉากกับพ้ืนโลก ซึ่งความเข้ม ของแสงจะมีค่าเท่ากับ 100 mW ต่อ ตร.ซม. หรือ 1,000 W ต่อ ตร.
เมตร ซึ่งมีค่าเท่ากับ AM 1.5 (Air Mass 1.5) และถ้าแสงอาทิตย์ท ามุม 60 องศากับพ้ืนโลกความเข้ม
ของแสง จะมีค่าเท่ากับประมาณ 75 mW ต่อ ตร.ซม. หรือ 750 W ต่อ ตร.เมตร ซึ่งมีค่าเท่ากับ AM2 
กรณีของแผงโซล่าเซลล์นั้นจะใช้ค่า AM 1.5 เป็นมาตรฐานในการวัดประสิทธิภาพของแผง 
อุณหภูม ิ

กระแสไฟ (Current) จะไม่แปรตามอุณหภูมิที่เปลี่ยนแปลงไป ในขณะที่แรงดันไฟฟ้า (โวลท์) 
จะลดลงเมื่ออุณหภูมิสูงขึ้น ซึ่งโดยเฉลี่ยแล้วทุกๆ 1 องศาที่เพ่ิมขึ้น จะท าให้แรงดันไฟฟ้าลดลง 0.5% 
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และในกรณีของแผงโซล่าเซลล์มาตรฐานที่ใช้ก าหนดประสิทธิภาพของแผงแสงอาทิตย์คือ ณ อุณหภูมิ 
25 องศา C เช่น ก าหนดไว้ว่าแผงแสงอาทิตย์มีแรงดันไฟฟ้าที่วงจรเปิด (Open Circuit Voltage หรือ 
V oc) ที่ 21 V ณ อุณหภูมิ 25 องศา C ก็จะหมายความว่า แรงดันไฟฟ้าที่จะได้จากแผงแสงอาทิตย์ 
เมื่อยังไม่ได้ตอ่กับอุปกรณ์ไฟฟ้า ณ อุณหภูมิ 25 องศา C จะเท่ากับ 21 V ถ้าอุณหภูมิสูงกว่า 25 องศา 
C เช่น อุณหภูมิ 30 องศา C จะท าให้แรงดันไฟฟ้าของแผงแสงอาทิตย์ลดลง 2.5% (0.5% x 5 องศา 
C) นั่นคือ แรงดันของแผงแสงอาทิตย์ที่ V oc จะลดลง 0.525 V (21 V x 2.5%) เหลือเพียง 20.475 
V (21V – 0.525V) สรุปได้ว่า เมื่ออุณหภูมิสูงขึ้น แรงดันไฟฟ้าก็จะลดลง ซึ่งมีผลท าให้ก าลังไฟฟ้า
สูงสุดของแผงแสงอาทิตย์ลดลงด้วย 
 
2.3.6 อุปกรณส์ าคญัของระบบการผลติกระแสไฟฟา้จากโซลา่เซลล ์

โซล่าเซลล์ผลิตไฟฟ้ากระแสตรง จึงน ากระแสไฟฟ้าไปใช้ได้เฉพาะกับอุปกรณ์ไฟฟ้ากระแสตรง
เท่านั้น หากต้องการน าไปใช้กับอุปกรณ์ไฟฟ้าที่ใช้ไฟฟ้ากระแสสลับหรือเก็บสะสมพลังงานไว้ใช้ต่อไป 
จะต้องใช้ร่วมกับอุปกรณ์อ่ืนๆ อีก โดยรวมเข้าเป็นระบบที่ผลิตกระแสไฟฟ้าจากโซล่าเซลล์ อุปกรณ์
ส าคัญๆ มีดังนี ้

 

 
รูปที่ 2.6 อุปกรณ์ท่ีใช้ในระบบโซล่าเซลล์ 

 
1.แผงโซล่าเซลล์ (Solar Module) ท าหน้าที่เปลี่ยนพลังงานแสงอาทิตย์ให้เป็นพลังงานไฟฟ้า 

ซึ่งเป็นไฟฟ้ากระแสตรงและมีหน่วยเป็นวัตต์ (Watt) มีการน าแผงโซล่าเซลล์หลายๆ เซลล์มาต่อกัน
เป็นแถวหรือเป็นชุด (Solar Array) เพ่ือให้ได้พลังงานไฟฟ้าใช้งานตามที่ต้องการ โดยการต่อกันแบบ
อนุกรม จะเพ่ิมแรงดันไฟฟ้า และการต่อกันแบบขนาน จะเพ่ิมพลังงานไฟฟ้า หากสถานที่ตั้งทาง
ภูมิศาสตร์แตกต่างกัน ก็จะมีผลให้ปริมาณของค่าเฉลี่ยพลังงานสูงสุดในหนึ่งวันไม่เท่ากันด้วย รวมถึง
อุณหภูมิก็มีผลต่อการผลิตพลังงานไฟฟ้า หากอุณหภูมิสูงขึ้น การผลิตพลังงานไฟฟ้าจะลดลง 

2.เครื่องควบคุมการประจุ (Charge Controller) ท าหน้าที่ประจุกระแสไฟฟ้าที่ผลิตได้จาก
แผงโซล่าเซลล์เข้าสู่แบตเตอรี่ และควบคุมการประจุกระแสไฟฟ้าให้มีปริมาณเหมาะสมกับแบตเตอรี่ 
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เพ่ือยืดอายุการใช้งานของแบตเตอรี่ รวมถึงการจ่ายกระแสไฟฟ้าออกจากแบตเตอรี่ด้วย ดังนั้น การ
ท างานของเครื่องควบคุมการประจุ คือ เมื่อประจุกระแสไฟฟ้าเข้าสู่แบตเตอรี่จนเต็มแล้ว จะหยุดหรือ
ลดการประจุกระแสไฟฟ้า (และมักจะมีคุณสมบัติในการตัดการจ่ายกระแสไฟฟ้าให้กับอุปกรณ์ไฟฟ้า 
กรณีแรงดันของแบตเตอรี่ลดลงด้วย) ระบบพลังงานแสงอาทิตย์จะใช้เครื่องควบคุมการประจุ
กระแสไฟฟ้าในกรณีที่มีการเก็บพลังงานไฟฟ้าไว้ในแบตเตอรี่เท่านั้น 

3.แบตเตอรี่ (Battery) ท าหน้าที่เป็นตัวเก็บพลังงานไฟฟ้าที่ผลิตได้จากแผงโซล่าเซลล์ไว้ใช้
เวลาที่ต้องการ เช่น เวลาที่ไม่มีแสงอาทิตย์ เวลากลางคืน หรือน าไปประยุกต์ใช้งานอ่ืนๆ แบตเตอรี่มี
หลายชนิดและหลายขนาดให้เลือกใช้งานตามความเหมาะสม 

4.เครื่องแปลงกระแสไฟฟ้า (Inverter) ท าหน้าที่แปลงพลังงานไฟฟ้าจากกระแสตรง (DC) ที่
ผลิตได้จากแผงโซล่าเซลล์ ให้เป็นพลังงานไฟฟ้ากระแสสลับ (AC) เพ่ือให้สามารถใช้ได้กับอุปกรณ์
ไฟฟ้ากระแสสลับ แบ่งเป็น 2 ชนิด คือ Sine Wave Inverter ใช้ได้กับอุปกรณ์ไฟฟ้ากระแสสลับทุก
ชนิด และ Modified Sine Wave Inverter ใช้ได้กับอุปกรณ์ไฟฟ้ากระแสสลับที่ไม่มีส่วนประกอบของ
มอเตอร์และหลอดฟลูออเรสเซนต์ที่เป็น Electronic ballast 
 
2.3.7การประยกุตใ์ชง้านโซลา่เซลลใ์นด้านตา่งๆ 

การน าพลังงานแสงอาทิตย์ซึ่งเป็นพลังงานจากธรรมชาติมาทดแทนพลังงานรูปแบบอ่ืนๆ 
ได้รับความสนใจและเป็นที่นิยมมากข้ึนสามารถน ามาใช้ให้เกิดประโยชน์อย่างมากมายในการด ารงชีวิต 
รวมถึงไม่เป็นการท าลายสิ่งแวดล้อม เช่น 
 
 
 

บ้านพักอาศัย ระบบแสงสว่างภายในบ้าน, ระบบแสงสว่างนอกบ้าน (ไฟสนาม, ไฟโรงจอด
รถ และโคมไฟรั้วบ้าน ฯลฯ), อุปกรณ์ไฟฟ้าชนิดต่างๆ , ระบบเปิด-ปิดประตู
บ้าน, ระบบรักษาความปลอดภัย, ระบบระบายอากาศ, เครื่องสูบน้ า, เครื่อง
กรองน้ า และไฟส ารองยามฉุกเฉิน ฯลฯ 

ระบบสูบน้ า อุปโภค, สาธารณูปโภค, ฟาร์มเลี้ยงสัตว์, เพาะปลูก, ท าสวน-ไร่, เหมืองแร่ 
และชลประทาน ฯลฯ 

ระบบแสงสว่าง โคมไฟป้ายรถเมล์, ตู้โทรศัพท์, ป้ายประกาศ, สถานที่จอดรถ, แสงสว่าง
ภายนอกอาคาร และไฟถนนสาธารณะ ฯลฯ 

ระบบประจุแบตเตอรี่ ไฟส ารองไว้ใช้ยามฉุกเฉิน, ศูนย์ประจุแบตเตอรี่ประจ าหมู่บ้านในชนบทที่ไม่มี
ไฟฟ้าใช้, แหล่งจ่ายไฟส าหรับใช้ในครัวเรือนและระบบแสงสว่างในพ้ืนที่
ห่างไกล ฯลฯ 

ท าการเกษตร ระบบสูบน้ า, พัดลมอบผลผลิตทางการเกษตร และเครื่องนวดข้าว ฯลฯ 

เลี้ยงสัตว์ ระบบสูบน้ า, ระบบเติมออกซิเจนในบ่อน้ า (บ่อกุ้งและบ่อปลา) และแสงไฟ
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ดักจับแมลง ฯลฯ 

อนามัย ตู้เย็น/กล่องท าความเย็นเพ่ือเก็บยาและวัคซีน, อุปกรณ์ไฟฟ้าทางการแพทย์ 
ส าหรับหน่วยอนามัย, หน่วยแพทย์เคลื่อนที่ และสถานีอนามัย ฯลฯ 

คมนาคม สัญญาณเตือนทางอากาศ, ไฟน าร่องทางขึ้น-ลงเครื่องบิน, ไฟประภาคาร, ไฟ
น าร่องเดินเรือ, ไฟสัญญาณข้ามถนน, สัญญาณจราจร, โคมไฟถนน และ
โทรศัพท์ฉุกเฉิน ฯลฯ 

สื่อสาร สถานีทวนสัญญาณไมโครเวฟ, อุปกรณ์โทรคมนาคม, อุปกรณ์สื่อสารแบบ
พกพา (เช่น วิทยุสนามของหน่วยงานบริการและทหาร) และสถานีตรวจสอบ
อากาศ ฯลฯ 

บันเทิงและ 
พักผ่อนหย่อนใจ 

แหล่งจ่ายไฟฟ้าส าหรับบ้านพักตากอากาศในพ้ืนที่ห่างไกล, ระบบประจุ
แบตเตอรี่แบบพกพาติดตัวไปได้ และอุปกรณ์ไฟฟ้าที่ให้ความบันเทิง ฯลฯ 

พ้ืนที่ห่างไกล ภูเขา, เกาะ, ป่าลึก และพ้ืนที่สายส่งการไฟฟ้าเข้าไม่ถึง ฯลฯ 

อวกาศ ดาวเทียม 

 
2.4 เซนเซอร์ตรวจวดัอณุหภมู ิ(Temperature Sensor) 

การตรวจวัดอุณหภูมิใช้รูปแบบ การเปลี่ยนแปลงระดับแรงดันไฟฟ้าจากสัญญาณอนาล็อก
ไปสู่ สัญญาณดิจิตอล โดยสัมพันธ์กับอุณภูมิ มีรูปแบบใหญ่ ๆ ของ เซนเซอร์ อยู่ด้วยกัน 3 รูปแบบ 
คือ Thermocouple คือ อุปกรณ์วัดอุณหภูมิโดยใช้หลักการเปลี่ยนแปลงอุณหภูมิ เป็น
แรงเคลื่อนไฟฟ้า ท ามาจากโลหะตัวน าที่ต่างชนิดกัน 2 ตัว มาเชื่อมต่อปลายทั้งสองเข้าด้วยกัน ที่
ปลายด้านหนึ่ง เรียกว่า "จุดอุณหภูมิ" ส่วนปลายอีกด้านหนึ่งปล่อยเปิดไว้ เรียกว่า "จุดอ้างอิง" หากที่
จุดวัดอุณหภูมิและจุดอ้างอิงมีอุณหภูมิต่างกันก็จะท าให้มีการน ากระแส ในวงจร Thermocouple 
Resistance Temperature Detector (RTD) คือ ตัวเซ็นเซอร์อุณหภูมิที่ใช้หลักการเปลี่ยนแปลงค่า
ความต้านทานของโลหะ ซึ่งค่าความต้านทานดังกล่าวจะมีค่าเพ่ิมตามอุณหภูมิ ความต้านทานของ
โลหะที่เพ่ิมขึ้นนี้ เรียกว่า “สัมประสิทธิ์การเปลี่ยนแปลงอุณหภูมิแบบบวก” นิยมน าไปใช้ในการวัด
อุณหภูมิในช่วง -270 to 850 °C. วัสดุที่น ามาใช้จะเป็นโลหะที่มีความต้านทานจ าเพาะต่ า เช่น 
แพลทินัม, ทังสเตน และ นิกเกิล 
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รูปที่ 2.7 เซนเซอร์ตรวจวัดอุณหภูมิชนิดต่างๆ 

 

      Thermistor เป็น อุปกรณ์ความต้านทานชนิดที่สามารถเปลี่ยนค่าความต้านทานเมื่อได้รับความ
ร้อน โดยที่ค่าความต้านทานจะเปลี่ยนแปลงแบบไม่เป็นเชิงเส้น กับอุณหภูมิ แบ่งเป็น 2 ลักษณะ คือ 
Positive Temperature Comitial (PTC) เป็น ชนิดที่ปกติจะมีค่าความต้านทานต่ า เมื่อได้รับความ
ร้อนจะท าให้มีค่าความต้านทานสูงขึ้นตามล าดับอุณหภูมิ น าไปใช้ตรวจสอบระดับความร้อน หรือท า
ให้เกิดความร้อนขึ้นเพ่ือควบคุมการจ่ายแรงดันไฟฟ้าให้กับขดลวด เช่น วงจรล้างสนามแม่เหล็ก
อัตโนมัติของเครื่องรับโทรทัศน์สี(Degaussingcoil)เป็นต้น 
        Negative Temperature Comitial (NTC) เป็นชนิด ที่ปกติจะมีความต้านทานสูงเมื่อได้รับ
ความร้อน ค่าความต้านทานจะต่ าลง ใช้งานด้านการตรวจสอบความร้อนเพื่อควบคุมระดับการท างาน 
เช่น ในวงจรขยายเสียงที่ดีใช้ตรวจจับความร้อนท่ีเกิดจากการท างานแล้วป้อนกลับไปลด การท างาน
ของวงจรให้น้อยลง เพื่ออุปกรณ์หลักจะไม่เกิดความร้อนมากจนเกินไป 
วงจรการต่ออุปกรณ์ 

 

รูปที่ 2.8 Bridge-Nulling A/D Converter 
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2.4.1 โมดลูเซน็เซอรว์ดัอณุหภมูิ 
โมดูลเซ็นเซอร์วัดอุณหภูมิเป็นอุปกรณ์ที่ท าหน้าที่เปลี่ยนระดับอุณหภูมิเป็นสัญญาณไฟฟ้าที่มี

ความ เที่ยงตรงสูง เช่น IC อุณหภูมิ เซนเซอร์แบบนี้จะให้ความเที่ยงตรงของค่าที่อ่านจากจากเทอมิ
สเตอร์ ไอซีตระกูล 335 เช่น LM135/LM235/LM335 มีความไวทางด้านเอาต์พุตเป็น 10 mV/° K ,
ไอซีตระกูล 34 เช่น เบอร์ LM34 จากบริษัท National Semiconductor 

DS1820 

 
รูปที่ 2.9 เซ็นเซอร์วัดอุณหภูมิรุ่น DS18B20 

 
2.4.2 การใชง้านเซน็เซอรว์ดัอุณหภูมิ 
เซน็เซอรว์ดัอณุหภูมภิายในอาคาร 

       เซ็นเซอร์วัดอุณหภูมิภายในบรรจุมาในกล่องส าหรับติดผนัง ซึ่งมาพร้อมกับแผงสวิตช์มาตรฐาน 
ควรติดตั้งเซ็นเซอร์ไว้กึ่งกลางของบริเวณที่ต้องการวัด ห่างจากประตู หน้าต่าง ช่องลม เครื่องท าความ
ร้อน และผนังด้านนอกที่อาจส่งผลต่อการอ่านค่าอุณหภูมิได้ โดยติดสูงจากพ้ืนสี่ถึงหกฟุตและยึดด้วย
ตะปูเกลียวที่ให้มาดังภาพ 

เครื่องวดัอณุหภูมสิ าหรบัช่องแอร์และวอลค์-อิน บ็อกซ ์

เครื่องวัดอุณหภูมิแบบแท่งขนาด 12 นิ้วสามารถใช้วัดอุณหภูมิทั้งในช่องลมเข้าและออกของ 
AHU หรือ RHU เครื่องวัดสามารถยึดไว้ด้านใดของช่องแอร์ก็ได้ด้วยสกรูเกลียวปล่อย โดยเจาะรู
เส้นผ่าศูนย์กลาง  0.250” รูป 30 แสดงภาพการติดตั้งเครื่องวัดแบบ 
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เซน็เซอรว์ดัอณุหภูมภิายนอกอาคาร 

เซ็นเซอร์วัดอุณหภูมิโดยรอบหรือภายนอกอาคารควรติดตั้งไว้ทางด้านเหนือของอาคาร (ด้วย
แคลมป์ยางรัดท่อทั้งนี้Emersonได้แถมกรอบอลูมิเนียมและ แคลมป์มาในชุดดังรูป 29 (ไม่รวมสาย
รัด)ส าหรับซีกโลกเหนือ) ภายใต้ชายคาเพ่ือป้องกันไม่ให้ไอร้อนจากแสงอาทิตย์ส่งผลต่อการวัดค่า
อุณหภูมิ ส่วนสถานที่ในซีกโลกใต้ให้ติดตั้งเซ็นเซอร์ไว้ทางด้านใต้ของอาคารในลักษณะเดียวกัน โดย
สามารถยึดเซ็นเซอร์ไว้ 

เครื่องวดัอณุหภูมแิบบแท่ง/จุม่ 

สามารถใช้กับของเหลวได้ ต่างจากเครื่องวัดแบบจุ่มที่ถูกออกแบบมาเพ่ือวัดอุณหภูมิ
ของเหลวซึ่งมีเครื่องวัดอุณหภูมิแบบแท่ง/จุ่มสามารถใช้ตรวจสอบอุณหภูมิ โดยเครื่องวัดแบบแท่ง
ส าหรับใช้กับช่องแอร์เท่านั้นไม่ปลอกหุ้มอีกชั้น ในการติดตั้งให้เจาะรูเพ่ือยึดเครื่องวัดแบบแท่งหรือ
ปลอกเครื่องวัดแบบจุ่ม (ต้องใช้แท็ปยึด) เมื่อเจาะรูแล้ว ขันตะปูเกลียวเพ่ือยึดเครื่องวัดแบบแท่งหรือ
ปลอกเข้ากับรูที่เจาะไว้ โดยใช้วิธีเดียวกันในการยึดปลอก ตรวจดูให้แน่ใจว่าปลอกของเครื่องวัดชนิด
จุ่มได้เคลือบปิดกันน้ าเป็นอย่างดีแล้ว เมื่อติดตั้งปลอกเครื่องวัดแบบจุ่มแล้ว ให้ขันตะปูเกลี ยวเพ่ือยึด
เครื่องวัดอุณหภูมิเข้ากับปลอกเป็นอันเสร็จ 

 
เซน็เซอรแ์บบยดึทอ่ 
ลูกลอยหรือเซ็นเซอร์แบบยึดท่อที่ติดตั้งบนท่อสารท าความเย็นควรจะยึดไว้ด้วยสายเคเบิลอุณหภูมิต่ า 
แพนดวิท หมายเลข PLT2S-M120 หรือใกล้เคียง ในการติดตั้งเซ็นเซอร์แบบยึดท่อให้ทาบด้านโค้ง
ของเซ็นเซอร์เข้ากับท่อ จากนั้นร้อยสายเคเบิลผ่านร่องด้านบนเซ็นเซอร์ และใช้สายเคเบิลอีกเส้นรัด
สายไฟเข้ากับท่ออีกทีเพ่ือความแน่นหนา (ผ่อนสายเคเบิลที่รัดช่วงสายไฟกับกล่องเซ็นเซอร์เล็กน้อย
ไม่ให้แน่นจนเกินไป) ทั้งนี้เซ็นเซอร์ที่ติดตั้งบนท่อสารท าความเย็นนั้นควรจะหุ้มฉนวนเพื่อป้องกันการ
เหนี่ยวน าจากอากาศรอบๆ โดยแนะน าให้ใช้ฉนวนชนิดมีกาวในตัวที่ไม่ดูดความชื้นเพื่อกันการจับตัว
เป็นน้ าแข็งบริเวณเซ็นเซอร์ 

2.4.3 บอรด์ไมโครคอนโทรเลอร ์Arduino 

บอร์ด Arduino ถือว่าเป็น Open Hardware Platform ที่ถูกพัฒนาขึ้นโดยมี Micro-controller 
ของ Atmel เป็นหัวใจหลัก บอร์ด Arduino ที่ผลิตออกมาจ าหน่ายในปัจจุบันมีทั้งหมด 20 รุ่น แต่ละ
รุ่นจะมีลักษณะภายนอกที่แตกต่างกัน รวมถึงคุณสมบัติต่างๆด้วย (บอร์ดบางรุ่นใช้ชื่อเดียวกันแต่มี
รายละเอียดของ spec แตกต่างกัน เช่น บอร์ดรุ่น Arduino Pro กับ Arduino Nano, LilyPad 
Arduino) 
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รูปที่ 2.10 บอร์ดไมโครคอนโทรเลอร์ Arduino ชนิดต่างๆ 

 

2.4.4 ความแตกต่างของ Arduino กบั ไมโครคอนโทรเลอรอ์ื่นๆ 

การใช้ไมโครคอนโทรเลอร์ไหนก็ตาม ก็ต้องมีบอร์ดที่จะใช้ ซึ่งบนบอร์ด จะมี MCU จะเป็น
ตัวใหนก็ตาม เช่น PIC, Atmel หรือ พวก MCS 51 ฯ  เมื่อมีบอร์ดแล้ว ก่อนที่จะใช้ ก็ต้องเขียน
โปรแกรมข้ึนมา บน PC โดยบน PC นี้ก็จะมีอุปกรณ์ ( โปรแกรม หรือที่เรียกว่า Integrate 
Development Environment == IDE ) ให้เขียน เช่นบน PIC ก็จะมีโปรแกรมที่ชื่อ MPLab ใน 
Atmel ก็จะมี Atmel Studio 6 (AS6) ให้มาใช้เพื่อพัฒนา สิ่งที่อยากจะให้ mcu ท างานให้ โดยจะ
เขียนโปรแกรมขึ้นมา จะด้วยภาษาอะไรก็ตาม เช่น ภาษา C, Pascal หรือ ภาษา Basic ฯ และ IDE นี้ 
แท้จริงแล้ว ก็คือโปรแกรมที่ท ามาให้ใช้ เพ่ือความสดวก ในการพัฒนาโปรแกรม ตัวโปรแกรมเองก็ถูก
พัฒนามาด้วยการเขียนด้วยภาษาอะไรก็ได้ เช่น ถูกพัฒนามาด้วย ภาษา C เช่น AS6 หรือ จะเป็น
ภาษา pascal ( Delphi )  หรือจะเป็น Java ( Arduino) ก็ได้ รูปร่างหน้าตาขึ้นกับบริษัทที่ออกแบบ
มา  
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รูปที่ 2.11 โปรแกรม Arduino 
 

เมื่อเขียนโปรแกรมขึ้นมาแล้ว ก็จะต้องเปลี่ยน ( Compile ) ให้เป็นภาษาเครื่อง เพ่ือ MCU 
จะได้เอาไปท างานตามที่ต้องการ  เมื่อ compile เสร็จแล้วก็จะได้โปรแกรมที่เป็น ภาษาเครื่องขึ้นมา 
ที่เรียก file ที่ได้มาว่า hex file   เมื่อได้มาแล้ว ก็ต้องเอา ภาษาเครื่อง ( hex file ) นี้ ไปบรรจุเข้าไป
ในหน่วยความจ าของ MCU ที่อยู่บนตัวบอร์ดที่ใช้ กรรมวิธีการเอาไปลงบน MCU อันนี้เรียกว่า 
"burn" hex file หรือ จะเรียกว่า "flash" hex หรือจะเรียกว่า "program" hex file เข้าไปใน flash 
memory กรรมวิธีในการที่จะ "burn" หรือ "flash" หรือจะ "program" hex file นี้ ก็ต้องอาศัย
อุปกรณ์ hardware ที่เรียกว่า programmer ซึ่งเป็นอุปกรณ์ต่างหาก ที่ผู้จะใช้ mcu ต้องจัดหามา 
PIC อุปกรณ์ตัวนี้ก็มีอยู่หลายตัว เช่น PICKit 2 และ PICKit3 เป็นต้น ในสาย Atmel ก็จะมี 
programmer อยู่หลายตัวมาก ก็จะมี AVRISP MK II และ AVR Dragon เมื่อได้โปรแกรม และ 
compile ให้ได้เป็นภาษาเครื่องแล้ว ก็ยังต้องอาศัย programmer โดยจะไปคว้า hex file ที่ได้จาก
โปรแกรม IDE ( เช่น MPLab หรือ AVR Studio/Atmel Studio ) เพ่ือส่ง hex file นี้ ผ่าน 
programmer  ไปยัง developement board  ดัง diagram ข้างบน แค่นี้ mcu ก็จะท างานให้
ตามท่ีต้องการ นี่คือ หลักการทั่วไปของทั้ง PIC , Atmel or MCS 51 และอ่ืนๆ   
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Arduino ตา่งจาก PIC หรือตวัอืน่ๆอยา่งไร  
หน่วยความจ าที่จะบรรจุ hex file เข้าไปใน MCU นั้น มีอยู่สองแบบ คือ หน่วยค าจ าที่

โปรแกรมเข้าไปอยู่ ซึ่งจะไปอยู่ส่วนล่างสุดของ หรือที่เรียกว่า program Section และอีกส่วนหนึ่งที่
ปลายสุดโต่งบนสุดของ program memory นี้ ส่วนนี้จะท าหน้าที่พิเศษ ที่เรียกว่า bootloader 
Section ในส่วนนี้ เป็นที่อยู่ของ โปรแกรมพิเศษที่เรียกว่า bootloader   
    bootloader คืออะไร คือโปรแกรมซึ่งส่วนใหญ่ไม่ใหญ่โตมากนัก ที่ท าหน้าที่ทันทีที่เปิดเครื่องเมื่อ 
mcu ที่มีโปรแกรมชนิดที่เรียกว่า bootloader แล้ว ก็สามารถติดต่อกับ MCU โดยไม่ต้องอาศัย 
programmer เลย และสามารถติดต่อจาก PC โดยใช้ผ่าน serial communication เข้าไปยัง MCU 
เลยนี่คือ ลักษณะหนึ่งของบอร์ด  arduino ซึ่งใช้ chip ของ Atmel กล่าวคือ ตัว MCU จะมีโปรแกรม 
bootloader ใส่เข้ามาให้เรียบร้อยแล้ว ( ท าให้ประหยัดค่า programmer)  
 

 
รูปที่ 2.12 โครงสร้าง PIC 

 
อีกสิ่งหนึ่งที่เป็นจุดดึงดูดให้คนหันมาใช้ arduino มากก็คือ ให้ library เข้ามาใช้มากมาย ท าให้
สามารถพัฒนาสิ่งที่อยากจะท า จะใช้ ได้ง่าย หากดูจากสิ่งที่ผู้คนพัฒนาบน arduino นั้น จะเห็นว่ามี
คนคิดประดิษฐ์ท าส่งของต่างๆแยะมาก ก็คือการที่ขาดองค์ความรู้เรื่องที่ต้องการจะท ามากกว่า และ
ไม่ต้องกลัวว่า arduino จะรองรับไม่ได้  
  สรุปว่า Arduino คือการเอา Atmel chip คือต้ว Atmega 168/328 มาบรรจุ bootloader 
ซึ่งท าให้การ burn หรือ flash หรือจะprogramภาษาเครื่อง (hex file ) ง่ายขึ้น  
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Arduino คืออะไร 

 
รูปที่ 2.13 บอร์ด Arduino 

 
         Arduino อ่านว่า (อา-ดู-อิ-โน่ หรือ อาดุยโน่) เป็นบอร์ดไมโครคอนโทรเลอร์ตระกูล AVR ที่มี
การพัฒนาแบบ OpenSource คือมีการเปิดเผยข้อมูลทั้ งด้าน Hardware และ Software ตัว 
บอร์ด Arduino ถูกออกแบบมาให้ใช้งานได้ง่าย ดังนั้นจึงเหมาะส าหรับผู้เริ่มต้นศึกษา ทั้งนี้ยังสามารถ
ดัดแปลง เพ่ิมเติม พัฒนาต่อยอดทั้งตัวบอร์ด หรือโปรแกรมต่อได้อีกด้วย 
         ความง่ายของบอร์ด Arduino ในการต่ออุปกรณ์เสริมต่างๆ คือสามารถต่อวงจรอิเล็กทรอนิคส์
จากภายนอกแล้วเชื่อมต่อเข้ามาที่ขา I/O ของบอร์ด (ดูตัวอย่างรูปที่ 1) หรือเพ่ือความสะดวกสามารถ
เลือกต่อกับบอร์ดเสริม (Arduino Shield) ประเภทต่างๆ (ดูตัวอย่างรูปที่ 2) เช่น Arduino XBee 
Shield, Arduino Music Shield, Arduino Relay Shield, Arduino Wireless Shield, Arduino 
GPRS Shield เป็นต้น มาเสียบกับบอร์ดบนบอร์ด Arduino แล้วเขียนโปรแกรมพัฒนาต่อได้เลย 
 
 
 
 
 
 
  

 

 

 

 

 

 

 

 

http://en.wikipedia.org/wiki/Arduino
http://en.wikipedia.org/wiki/Arduino
http://en.wikipedia.org/wiki/Arduino
http://www.thaieasyelec.com/products/development-boards/arduino/unofficial-shields.html
http://www.thaieasyelec.com/products/development-boards/xbee-shield-v2-0-detail.html
http://www.thaieasyelec.com/products/development-boards/xbee-shield-v2-0-detail.html
http://www.thaieasyelec.com/products/development-boards/music-shield-v2-0-detail.html
http://www.thaieasyelec.com/products/development-boards/relay-shield-v2-0-detail.html
http://thaieasyelec.com/products/development-boards/arduino/official-shields-made-in-italy/wireless-sd-shield-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino/unofficial-shields/gprs-shield-v2-0-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino/unofficial-shields/gprs-shield-v2-0-detail.html
http://en.wikipedia.org/wiki/Arduino


 

 

 

 

 

 

 

 

21 

 

 

 รูปที่ 2.14 การต่อใช้งานแบบต่างๆของบอร์ด Arduino 

 
จดุเดน่ที่ท าใหบ้อรด์ Arduino เปน็ทีน่ยิม 

1. ง่ายต่อการพัฒนา มีรูปแบบค าสั่งพื้นฐาน ไม่ซับซ้อนเหมาะส าหรับผู้เริ่มต้น 
2. มี Arduino Community กลุ่มคนที่ร่วมกันพัฒนาที่แข็งแรง  
3. Open Hardware ท าให้ผู้ใช้สามารถน าบอร์ดไปต่อยอดใช้งานได้หลายด้าน 
4. ราคาไม่แพง 
5. Cross Platform สามารถพัฒนาโปรแกรมบน OS ใดก็ได้  

  
จะเห็นว่า บอร์ด Arduino คือบอร์ดไมโครคอนโทรลเลอร์ที่มี โปรแกรมภาษาที่ง่ายต่อการใช้

งาน สามารถเรียกฟังก์ชั่นต่างๆ ของ AVR ออกมาใช้ท างานได้อย่างง่ายดาย ไม่ว่าจะเป็น PWM , 
Serial , Port In Out , A to D, หรือแม้กระทั่งการใช้งานกับ LCD Graphic ต่างๆ ก็มีผู้คนทั่วโลก
พัฒนาให้สามารถน ามาใช้งานต่อร่วมได้โดยง่าย อีกทั้งยังมี การเชื่อมต่อกับ คอมพิวเตอร์แบบ USB 
ท าให้การโปรแกรมต่างๆ นั้น ท าได้โดยสะดวก การเขียนโปรแกรมเป็นเรื่องง่ายมากกับการเทียบการ
ใช้ไมโครคอนโทรลเลอร์ที่ต้องเขียนโปรแกรมเองทั้งหมดแต่ บอร์ด Arduino นี้เขียนโปรแกรมด้วย
ภาษาง่ายๆ สามารถท าความเข้าใจได้ง่ายและมีประสิทธิภาพสูงมากๆในเรื่องของโปรแกรม 
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รปูแบบการเขยีนโปรแกรมบน Arduino 
  

 
รูปที่ 2.15 รูปแบบการเชื่อมต่อบอร์ด 

  

1. เขียนโปรแกรมบนคอมพิวเตอร์ผ่านทางโปรแกรม ArduinoIDE ซึ่งสามารถดาวน์โหลดได้จาก
Arduino.cc/en/main/software 

2.  หลังจากที่ เขียนโค้ดโปรแกรมเรียบร้อยแล้วให้เลือกรุ่นบอร์ด Arduino ที่ใช้และ
หมายเลข Com port  
 

  

 

  

รูปที่ 2.16 เลือกรุ่นบอร์ด Arduino ที่ต้องการ upload 
 
  

 

 

 

 

 

 

 

 

http://www.arduino.cc/en/main/software
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รูปที่ 2.17เลือกหมายเลข Comport ของบอร์ด 
  

3. กดปุ่ม Verify เ พ่ือตรวจสอบความถูกต้องและ Compile โค้ดโปรแกรมจากนั้นกด
ปุ่ม Upload โค้ด โปรแกรมไปยังบอร์ด Arduino ผ่านทางสาย USB เมื่ออับโหลดเรียบร้อยแล้ว จะ
แสดงข้อความแถบข้างล่าง “Done uploading” และบอร์ดจะเริ่มท างานตามที่เขียนโปรแกรมไว้ได้
ทันท ี
  

 

รูปที่ 2.18 Compile โปรแกรม 
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Layout & Pin out Arduino Board (Model: Arduino UNO R3)  
  

 
รูปที่ 2.19 ส่วนประกอบของบอร์ด Arduino 

  

1.USBPort: ใช้ส าหรับต่อกับ Computer เพ่ืออับโหลดโปรแกรมเข้า MCU และจ่ายไฟให้กับบอร์ด 
2.Reset Button: เป็นปุ่ม Reset ใช้กดเมื่อต้องการให้ MCU เริ่มการท างานใหม่ 
3.ICSP Port ของ Atmega16U2 เป็นพอร์ตที่ใช้โปรแกรม Visual Com port บน Atmega16U2 
4. I/OPort:Digital I/O ตั้งแต่ขา D0 ถึง D13 นอกจากนี้ บาง Pin จะท าหน้าที่อ่ืนๆ เพ่ิมเติมด้วย 
เช่น Pin0,1 เป็นขา Tx,Rx Serial, Pin3,5,6,9,10 และ 11 เป็นขา PWM   
5.ICSP Port: Atmega328 เป็นพอร์ตที่ใช้โปรแกรม Bootloader 
6. MCU: Atmega328 เป็น MCU ที่ใช้บนบอร์ด Arduino 
7. I/OPort: นอกจากจะเป็น Digital I/O แล้ว ยังเปลี่ยนเป็น ช่องรับสัญญาณอนาล็อก ตั้งแต่ขา A0-
A5 
8.PowerPort ไฟเลี้ยงของบอร์ดเมื่อต้องการจ่ายไฟให้กับวงจรภายนอกประกอบด้วยขาไฟเลี้ยง +3.3 
V, +5V, GND, Vin 
9. Power Jack: รับไฟจาก Adapter โดยที่แรงดันอยู่ระหว่าง 7-12 V  
10. MCU ของ Atmega16U2 เป็น MCU ที่ท าหน้าที่เป็น USB to Serial โดย Atmega328 จะ
ติดต่อกับ Computer ผ่าน Atmega16U2 
 
ประเภทของบอรด์Arduino แตล่ะ่ประเภท 
1. Arduino Uno R3 เป็นบอร์ด Arduino ที่ได้รับความนิยมมากที่สุด เนื่องจากราคาไม่แพง ส่วน
ใหญ่โปรเจคและ Library ต่างๆ ที่พัฒนาขึ้นมา Support จะอ้างอิงกับบอร์ดนี้เป็นหลัก และข้อดีอีก
อย่างคือ กรณีท่ี MCU เสีย สามารถซ้ือมาเปลี่ยนเองได้ 
  

 

 

 

 

 

 

 

 

http://www.thaieasyelec.com/products/development-boards/arduino-uno-r3-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino-uno-r3-detail.html
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รูปที่ 2.20 Arduino r3 
  

2. Arduino Uno SMD เป็นบอร์ดที่มีคุณสมบัติและการท างานเหมือนกับบอร์ด Arduino UNO 
R3 ทุกประการ แต่จะแตกต่างกับที่Package ของ MCU ซึ่งบอร์ดนี้จะมี  MCU ที่เป็น Package 
SMD (Arduino UNO R3 มี MCU ที่เป็น Package DIP)  

 
รูปที่ 2.21 Arduino Uno AMD 

   
3. Arduino Mega 2560 R3 เป็นบอร์ด Arduino ที่ออกแบบมาส าหรับงานที่ต้อง
ใช้ I/O มากกว่า ArduinoUnoR3  เช่นงานที่ต้องการรับสัญญาณจาก Sensor หรือควบคุม
มอเตอร์ Servo หลายๆ ตัว ท าให้ Pin I/O ของบอร์ด Arduino Uno R3 ไม่สามารถรองรับได้ ทั้งนี้
บอร์ด Mega 2560 R3 ยังมีความหน่วยความจ าแบบ Flash มากกว่า Arduino Uno R3 ท าให้
สามารถเขียนโค้ดโปรแกรมเข้าไปได้มากกว่า ในความเร็วของ MCU ที่เท่ากัน 
  

 
รูปที่ 2.22 Arduino Mega 2560 R3 

 

 

 

 

 

 

 

 

http://www.thaieasyelec.com/products/development-boards/arduino-uno-smd-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino-mega-2560-detail.html
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4. Arduino Mega ADK เป็นบอร์ดที่ออกแบบมาให้บอร์ด Mega 2560 R3 สามารถติดต่อกับ
อุปกรณ ์Android Deviceผ่านพอร์ตUSB Host ของบอร์ดได ้ 
 

  

รูปที่ 2.23 Arduino Mega ADK 
  

5. Arduino Leonardo การท างานจะคล้ายกับบอร์ด Arduino Uno R3 แต่มีการเปลี่ยน MCU ตัว
ใหม่เป็น ATmega32U4 ซึ่งมีโมดูลพอร์ต USB มาด้วยบนชิป (แตกต่างจากบอร์ด Arduino UNO 
R3 หรือ Arduino Mega 2560 ที่ต้องใช้ชิป ATmega16U2 ร่วมกับAtmega328 ในการเชื่อมต่อกับ
พอร์ต USB)    
ข้อควรระวัง: เนื่องจาก MCU เป็นคนละเบอร์กับ Arduino Uno R3 อาจะท าให้บอร์ด Shield บาง
ตัวหรือ Library ใช้ร่วมกันกับบอร์ดArduino Leonardo ไม่ได้ จ าเป็นต้องตรวจสอบก่อนใช้งาน 
  

 

รูปที่ 2.24 Arduino Leonardo 
 
 
 

  

 
 

 

 

 

 

 

 

 

 

http://www.thaieasyelec.com/products/development-boards/arduino-adk-rev3-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino-leonardo-headers-detail.html


 

 

 

 

 

 

 

 

27 

 

6. Arduino Mini 05 เป็นบอร์ด Arduino ขนาดเล็กที่ใช้ MCU เบอร์ ATmega328 เบอร์เดียวกับ
บอร์ด Arduino UNO R3    
ข้อแตกต่าง: บอร์ด Arduino Mini 05 จะไม่มีพอร์ต USB มาให้ ต้องต่อกับบอร์ด USB to Serial 
Converter เพ่ิมเม่ือต้องการโปรแกรมบอร์ด 
  

 

รูปที่ 2.25 Arduino Mini 05 
 

  
7. Arduino Pro Mini 328 3.3V เป็นบอร์ด Arduino ขนาดเล็ก ที่ใช้ MCU เบอร์ ATmega328 ซึ่ง
จะคล้ายกับบอร์ด Arduino Mini 05 แต่บนบอร์ดจะมี Regulator 3.3 V ชุดเดียวเท่านั้น ระดับ
แรงดันไฟที่ขา I/O คือ 3.3V 
  

 

รูปที่ 2.26 Arduino Pro Mini 328 3.3V 
 

  

 

 

 

 

 

 

 

 

http://www.thaieasyelec.com/products/development-boards/arduino/official-boards-made-in-italy/arduino-mini-05-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino-pro-mini-328-3-3v-8mhz-detail.html
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8. Arduino Pro Mini 328 5V เป็นบอร์ด Arduino ขนาดเล็ก ที่ใช้ MCU เบอร์ ATmega328
เช่นเดียวกับบอร์ด Arduino Mini 05 แต่บนบอร์ดจะมี Regulator 5V ชุดเดียวเท่านั้นระดับ
แรงดันไฟที่ขา I/O คือ 5V 
  

 

รูปที่ 2.27 Arduino Pro Mini 328 5V 
 

  
9. Arduino Ethernet with PoE module เป็นบอร์ด Arduino ที่ใช้ MCU เบอร์เดียวกับ Arduino 
Uno SMD ในบอร์ดมีชิป Ethernet และช่องส าหรับเสียบ SD Card รวมทั้งโมดูล POE ท าให้บอร์ดนี้
สามารถใช้แหล่งจ่ายไฟจากสาย LAN ได้โดยตรง โดยไม่ต้องต่อ Adapter เพ่ิม แต่บอร์ด Arduino 
Ethernet with PoE module นี้จะไม่มีพอร์ต USB ท าให้เวลาโปรแกรมต้องต่อบอร์ด USB 
toSerial Converter เพ่ิมเติม 
  

 

รูปที่ 2.28 Arduino Ethernet with PoE module 

 

 

 

 

 

 

 

 

http://www.thaieasyelec.com/products/development-boards/arduino-pro-mini-328-5v-16mhz-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino-ethernet-with-poe-module-detail.html
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 10. Arduino Ethernet without PoE module บอร์ดนี้จะตัดโมดูล POE ออกไป ต้องใช้ไฟจาก
พอร์ต Power Jack เท่านั้น คุณสมบัติอ่ืนๆ จะเหมือนกับบอร์ด Arduino Ethernet with PoE 
module  

 

รูปที่ 2.29 Arduino Ethernet without PoE module 

  

11. Arduino Due เ ป็ นบอร์ ด  Arduino ที่ เ ปลี่ ย นชิ ป  MCU ใหม่ ซึ่ ง จ า ก เดิ ม เ ป็ น
ตระกูล AVR เปลี่ยนเป็นเบอร์ AT91SAM3X8E (ตระกูลARMCortex-M3) แทนท าให้การประมวลผล
เร็วขึ้นแต่ยังคงรูปแบบโค้ดโปรแกรมของ Arduino ที่ง่ายอยู่ ข้อควรระวัง: เนื่องจาก MCUเป็นคนละ
เบอร์กับ Arduino Uno R3 อาจะท าให้บอร์ด Shield บางตัวหรือ Library ใช้ร่วมกันกับ
บอร์ด Arduino Leonardo ไม่ได้ จ าเป็นต้องตรวจสอบก่อนใช้งาน  
  

 

รูปที่ 2.30 Arduino Due 

 
 

 

 

 

 

 

 

 

 

 

 

 

http://www.thaieasyelec.com/products/development-boards/arduino-ethernet-rev3-without-poe-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino-ethernet-rev3-without-poe-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino-ethernet-rev3-without-poe-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino-ethernet-rev3-without-poe-detail.html
http://www.thaieasyelec.com/products/development-boards/arduino-due-detail.html
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ตัวอย่างการใช้ Arduino กับบอร์ดไมโครคอนโทรลเลอร์ 
1.   เปิดโปรแกรม Arduino IDE ที่ดาวน์โหลดมาจาก http://arduino.cc/en/Main/Software 

2.   เมื่อเปิดโปรแกรมแล้วจะพบกับหน้าต่างของ IDE ดังรูป 

 

รูปที่ 2.31 หน้าต่างโปรแกรม 

 

3.   ไปที่ Tools->Board แล้วเลือกให้ตรงกับบอร์ดที่ใช้งาน ส าหรับ Arduino UNO R3 ให้เลือก
บอร์ด Arduino UNO 

4.   เขียนโปรแกรมดังข้อความด้านล่างนี้ 

 

 

 

 

 

 

 

 

http://arduino.cc/en/Main/Software
http://www.ec.in.th/index.php?route=product/product&product_id=1002
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 รูปที่ 2.32 การเขียนโปรแกรม 

 

5.   จากนั้นคอมไพล์โปรแกรมโดยไปที่ Sketch->Verify / Compile 

 

รูปที่ 2.33 คอมไพล์โปรแกรม 
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6.   เมื่อคอมไฟล์เรียบร้อยจะมีข้อความปรากฏดังรูป 

 

รูปที่ 2.34 คอมไพล์เรียบร้อย 

7.   ต่อบอร์ด Arduino UNO R3 เข้ากับคอมพิวเตอร์ผ่านทางพอร์ต USB 

 

 

 

 

 

 

 

 

http://www.ec.in.th/index.php?route=product/product&product_id=1002
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รูปที่ 2.35 ต่อบอร์ด Arduino UNO R3 เข้ากับคอมพิวเตอร์ 

8.   จากนั้นให้ไปท่ี Tools->Serial Port และเลือกให้ตรงกับบอร์ด Arduino UNO ที่ใช้งาน (ส าหรับ
บอร์ด Arduino UNO R3 โปรแกรมจะเลือกให้อัตโนมัติ) 

 

รูปที่ 2.36 เลือก Serial Port 

 

 

 

 

 

 

 

 

 

http://www.ec.in.th/index.php?route=product/product&product_id=1002
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9.   โหลดโปรแกรมเข้าบอร์ด Arduino UNO โดยไปท่ี File->Upload 

 

รูปที่ 2.37 . โหลดโปรแกรมเข้าบอร์ด 

10.   จากนั้นเปิด Serial Monitor ของ Arduino IDE โดยไปท่ี Tools-> Serial Monitor 

 

รูปที่ 2.38 Serial Monitor 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

35 

 

11. เมื่อเปิด Serial Monitor จะได้ข้อความดังรูป 

 
 

รูปที่ 2.39 เมื่อเปิด Serial Monitor 

 

2.5 Zigbee and Xbee BASIC ตอน การใชง้าน Xbee เบื้องตน้ 

รู้จักX-CTU 
X-CTU เป็น software interface บนคอมพิวเตอร์ที่จะช่วยในการ update firmware หรือ 

ทดสอบการใช้งาน หรือ ปรับ parameter กับ Xbee โดยสามารถ download software มาได้ฟรี
จาก Digi (X-CTU Software) ส าหรับการใช้งาน สามารถอ่านจากคู่มือ X-CTU Configuration & 
Test Utility Software User Guide หลังจากท่ี Download ตัว Software มาแล้ว การ Install จะ
มีการ Download Firmware ล่าสุดจาก Digi ผ่าน internet   

 

 

 

 

 

 

 

 

http://www.digi.com/support/kbase/kbaseresultdetl.jsp?kb=125
http://www.digi.com/support/productdetl.jsp?pid=3352&osvid=57&s=316&tp=3
http://www.digi.com/support/productdetl.jsp?pid=3352&osvid=57&s=316&tp=3


 

 

 

 

 

 

 

 

36 

 

 

 

รูปที่ 2.40 หน้าตา Software X-CTU ที่ใช้ร่วมกับ Xbee (Free Download) 

 

รูจ้ัก Firmware 

ส าหรับ Xbee นั้น ในแต่ละรุ่นที่ซื้อ จะมี firmware ที่โปรแกรมมาแล้วจากทางโรงงาน ซึ่ง
สามารถดึงค่ามาดูได้โดยไปที่ Tab Modem Configuration แล้วกดปุ่ม Read  
หากซื้อ Xbee Pro Series 1 มา จะต้องเลือก firmware version ที่ใช้ร่วมกัน คือ 1081, 1082, 
1083, 1084 , ....   ซ่ึง firmware ล่าสุดจะถูก set ให้โดยอัตโนมัติ หากเลือก Xbee รุ่น จะต้องเลือก 
group XB24xxxx เป็นต้นไป ส่วนถ้าเลือกรุ่นPro มา ต้องเลือก XBP24xxxx ส าหรับ ในแต่ละ series 
นั้น จะลงท้ายไม่เหมือนกัน เช่น series2 ZB จะเป็น XB24-ZB 

  

 

 

 

 

 

 

 

 

http://www.itcomcenter.com/tips-view.asp?id=40&groupid=1&forward=1
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รูปที่ 2.41 เลือก modem 

 

รูปที่ 2.42 ต้ัง parameter 
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สามารถ Set Parameter ใน Tab Modem Configuration แล้ว กด write Firmware สามารถ
ทดลองใช้งานง่าย ๆ ด้วยการใช้อุปกรณ์ Dongle และ Xbee 1 คู่ สร้างเครือข่ายแบบ Point-to-
Point ร่วมกับ X-CTU เพ่ือก าหนด Parameter ให้กับ Xbee ผ่าน firmware และ X-CTU  
 
การตั้งคา่อปุกรณ ์

การทดสอบจะใช้อุปกรณ์ดังรูปด้านล่างคือประกอบด้วย Xbee Pro Series 1 และ Mini 
XbeeUSB DongleV2 ส าหรับเสียบอุปกรณ์กับคอมพิวเตอร์ ท าการเปิด X-CTU 2 หน้าต่าง แล้วไปที่
หน้า Tab Modem Configuration แล้วกด Read จะพบว่า X-CTU จะท าการ LoadFirmware 
ของ Xbee Pro Series1 ออกมาซึ่งจะเป็นค่าที่Setไว้แบบDefault  
 

 อุปกรณท์ี่ใชง้านในการทดสอบ 

 

 

รูปที่ 2.43 Mini Xbee USB Dongle V2  

 
MiniXbeeUSBDongleV2 (ETEE028A) 
เป็น Tool ที่ใช้ส าหรับท างานร่วมกับ ส าหรับ update firmware หรือ การ Config Parameter หรือ 
Update Firmware ผ่านคอมพิวเตอร์ ร่วมกับ Software X-CTU สามารถต่อ Xbee ร่วมกับ Mini 
Xbee USB Dongle ผ่าน USB Port ได้โดยตรง ซึ่งคอมพิวเตอร์จะมองเป็น Com Port (Serial 
UART) เนื่องจากใช้ IC FT232RL ซึ่งเป็น USB to Serial ในบอร์ดเดียว ไม่ต้องต่ออุปกรณ์ใด ๆ 
เพ่ิมเติม สามารถใช้ร่วมกับ Xbee ได้ทุกรุ่น 

 

 

 

 

 

 

 

 

http://thaieasyelec.com/products/wireless-modules/zigbee-802-15-4/xbee-series-1.html
http://thaieasyelec.com/products/wireless-modules/zigbee-802-15-4/mini-xbee-usb-dongle-v2-detail.html
http://thaieasyelec.com/products/wireless-modules/zigbee-802-15-4/mini-xbee-usb-dongle-v2-detail.html
http://thaieasyelec.com/products/wireless-modules/zigbee-802-15-4/xbee-series-1.html
http://thaieasyelec.com/products/wireless-modules/zigbee-802-15-4/mini-xbee-usb-dongle-v2-detail.html
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รูปที ่2.44 Xbee Convert PIN to 2.54 Pitch 

Xbee Convert PIN to 2.54 Pitch (ETEE019A) 

PCB ส าหรับแปลงขาของ Xbee Series 1 และ Series 2 ให้สามารถเสียบกับ Protoboard ได้
โดยตรง 

 

รูปที่ 2.45 Bluebee - Xbee Breakout board  

Bluebee - Xbee Breakout board (ETEE017) 
BlueBee เป็น Xbee Breadboard ที่สามารถต่อสายใช้งานได้, สามารถเพ่ิม sensor ที่ต้องการได้
เอง ตามที่ BlueBee จัด Footprint ไว้ให้ เหมาะกับการต่อโดยตรงเข้ากับ MCU 

 

 

 

 

 

 

 

 

http://thaieasyelec.com/products/wireless-modules/zigbee-802-15-4/mini-xbee-converter-detail.html
http://thaieasyelec.com/products/wireless-modules/zigbee-802-15-4/bluebee-xbee-breakout-board-detail.html
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รูปที่ 2.46 BlueBee Dongle 

 

BlueBee Dongle (ETEE017D) 
เป็น BlueBee - Xbee Breadboard ที่ใช้งานเป็น Xbee Dongle โดยต่อใช้งานร่วมกันกับ USB to 
Serial ส าหรับ update firmware หรือ การ config parameter ผ่าน คอมพิวเตอร์ 

  

ทดสอบการใชง้าน Xbee และ Software X-CTU 
1. ท าการ set parameter ให้ติดต่อกันแบบ Point to Point เมื่อท าการ
ต่อ Xbee Pro Series1 และ Mini Xbee USB Dongle V2 เข้ากับ PC ทั้ง 2 ชุดเรียบร้อยแล้วให้เปิด
โปรแกรม X-CTU ขึ้น 2 ชุดเช่นกัน แล้วท าการเลือก COM Port (UART) ในแต่ละชุดให้ถูกต้อง 

 

 

 

 

 

 

 

 

http://thaieasyelec.com/products/wireless-modules/zigbee-802-15-4/bluebee-dongle-xbee-usb-dongle-detail.html
http://thaieasyelec.com/products/wireless-modules/zigbee-802-15-4/xbee-series-1.html
http://thaieasyelec.com/products/wireless-modules/zigbee-802-15-4/mini-xbee-usb-dongle-v2-detail.html
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รูปที่ 2.47 set parameter ให้ติดต่อกันแบบ Point to Point 

  

2. ที่โปรแกรม X-CTU ให้เลือก Tab "Modem Configuration" แล้วท าการ set parameter โดยให้
ฝั่งหนึ่งเป็น End Device ด้วยการ Set Parameter ในหมวด Networking & Security >> CE=0 
และ ค่า MY = 1 และ ฝั่งอีกหนึ่ง เป็น Coordinator ด้วยการ Set Parameter ในหมวด 
Networking & Security >> (CE=1) และ ค่า MY = 2  ทั้งนี้ ได้ set baud rate ที่ตัว Xbee ทั้ง 2 
ตัวที่ 9600 bps (BD=3) 
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รูปที่ 2.47 set parameter 

 

3. ท าการ set ให้ parameter DH และ DL ของแต่ละฝั่งให้มีค่าเท่ากับ SH และ SL ของฝั่งตรงข้าม 
โดย SH SL เป็นค่า address ที่เปลี่ยนไม่ได้ (Read Only) เป็นค่าที่ใส่มาจากโรงงาน 

วิธีการดูว่า Xbee ของมีค่า SH และ SL เท่าไหร่ สามารถดูได้ 2 วิธีคือ ให้กด Read เพ่ือ Load ค่า
ของ Xbee เข้ามาจะท าให้ Click ดูค่า SH และ SL ได้และวิธีที่ 2 คือดูจากทางด้านใต้ของตัว Xbee 
จะมี Sticker ติดหมายเลข SH , SL มาให้แล้ว  

 
 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

บทที ่ 3 
หลักการท างานของอุปกรณแ์ละโปรแกรม 

ในการใชง้านระบบตรวจวดัอณุหภมูิอตัโนมตัโิดยผา่นเครือข่าย xbee 
โดยมแีหลง่จ่ายเปน็โซล่าเซลล์ 

3.1   บทน า 
 เนื้อหาในบทนี้จะกล่าวถึงโครงสร้างของระบบตรวจจับวัดอุณหภูมิของเซนเซอร์ หน้าที่และ
การใช้งานส่วนประกอบต่างๆ การเขียนโปรแกรมและใช้โปรแกรมควบคุมการท างาน และการ
เชื่อมต่อส่วนประกอบต่างๆ ให้ท างานร่วมกัน 
 
3.2   โครงสรา้งของระบบตรวจวดัอณุหภูมอิัตโนมตัโิดยผ่านเครือขา่ย xbeeโดยมีแหลง่จา่ยเปน็โซลา่
เซลล ์
  ระบบตรวจจับวัดอุณหภูมิของเซนเซอร์นี้ มีโครงสร้างในการท างานซึ่งประกอบไปด้วย
เซนเซอร์วัดอุณหภูมิ ds18b20 บอร์ดไมโครคอนโทรลเลอร์ Arduino (รุ่น Arduino Uno R3) 
โปรแกรม Arduino IDE ที่ใช้เขียนโปรแกรมลงในบอร์ดไมโครคอนโทรลเลอร์ Arduino และโปรแกรม 
X-ctu ใช้ในการเขียนโปรแกรมของ Xbee อุปกรณ์แสดงผลในระบบตรวจจับวัดอุณหภูมิของเซนเซอร์ 
ประกอบไปด้วยจอแสดงผล LCD วงจรเสียง (Alarm) และแหล่งจ่ายภาคส่งที่ใช้โซล่าเซลล์ 

 

รูปที่ 3.1 โครงสร้างรวมของระบบ 
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รูปที่ 3.2 โครงสร้างระบบภาคส่ง 

 

รูปที่ 3.3 โครงสร้างระบบภาครับ 
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รูปที่ 3.4 การเชื่อมต่อวงจรภาคส่ง 

 

รูปที่ 3.5 การเชื่อมต่อวงจรภาครับ 
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3.3   อุปกรณ์ทีใ่ช้ในระบบตรวจวดัอณุหภูมอิัตโนมตัโิดยผ่านเครือขา่ย xbeeโดยมีแหลง่จา่ยเปน็โซลา่
เซลล ์

3.3.1  เซนเซอรว์ดัอุณหมู ิDS18B20 

 ไอซี DS1820 เป็นไอซีที่มีระบบการสื่อสารข้อมูลอนุกรมแบบหนึ่งสายซึ่งถือได้ว่าเป็นระบบที่
มีความชาญฉลาด และใช้จ านวนสายสัญญาณเพียง 1 เส้นเท่านั้น โดยไม่ต้องมีสายสัญญาณนาฬิกามา
ควบคุมจังหวะการถ่ายทอดข้อมูลเหมือนกับระบบสื่อสารข้อมูลอนุกรมในแบบอ่ืน สายข้อมูลจะท า
หน้าที่เสมือนเป็นสายสัญญาณนาฬิกาในตัว ส่วนค่าของข้อมูลจะพิจารณาจากลักษณะของรูปสัญญาณ
ทีป่รากฏบนสายสัญญาณในแต่ละช่องของเวลาซึ่งเรียกว่า ไทม์สล็อต (Time Slot) โดยคาบเวลาต่ าสุด
และสูงสุดของสถานะต่าง ๆ ในการสื่อสารข้อมูลในแต่ละไทม์สล็อตมีการก าหนดขอบเขตไว้อย่าง
ชัดเจนการถ่ายทอดข้อมูลจะเกิดขึ้นในแต่ละไทม์สล็อดนั้น รูปแบบการถ่ายทอด ข้อมูลจะเป็นแบบอะ
ซิงโครนัสในระดับบิต ไม่มีการก าหนดความยาวของข้อมูลเป็นระดับไบต์ระบบสื่อสารแบบนี้เหมาะที่
จะใช้ในการสื่อสารข้อมูลระหว่างไอซีแผงวงจรเดียวกัน 

 เหตุผลที่เลือก DS18S20 เนื่องจากสิ่งที่เราต้องการในการวัดอุณหภูมินี้เราต้องการระบบบัส
ที่สามารถเดินสายได้ในระยะไกลซึ่งเหมาะส าหรับระบบบัสแบบ 1-Wire ดูจะเหมาะกว่าในแง่ของ
ความสะดวกในการใช้งานระยะห่างของแต่ละจุดที่วัดความแม่นย าของค่าที่วัดได้ใช้ไอซีเบอร์ 
DS18S20 ซึ่งมีระดับความผิดพลาดที่ 0.5องศาเซลเซียส DS18S20 เป็น IC วัดอุณหภูมิแบบดิจิตอล 
ของ Dallas Semiconductor สามารถวัดอุณหภูมิเป็นหน่วยองศา C ในช่วง -55C ถึง 125 C ที่
ความละเอียด 9-12 บิต และมีความแม่นย าอยู่ที่ 0.5C ในช่วง -10C ถึง 85 C ในกรณีที่เป็นตัวถังแบบ 
TO-92 นั้นจะมีโครงสร้าง และขาดังแสดงในรูปที่ 3.6 

 
 

 

 

 

 

รูปที่ 3.6 วงจรพื้นฐานของ เซนเซอร์ DS18B20 

หลักการท างานของเซนเซอรว์ดัอณุหภูม ิDS18S20  
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  ในกระบวนการเริ่มต้นการสื่อสารแบบ 1-wire ทั้งหมดนั้น อุปกรณ์ Master การสื่อสารด้วย
การสร้าง Reset pulse ก่อน เมื่ออุปกรณ์ Slave ได้รับ Reset pulse ก็จะสร้าง Presence pulse 
เพ่ือตอบรับการขอเริ่มการสื่อสารนั้น ซึ่งมีรายละเอียดของช่วงเวลาต่าง ๆ ดังแสดง 

รูปที่ 3.7 การเริ่มติดต่อสื่อสารแบบ 1-wire ด้วย Reset pulse และ Presence pulse 

จากรูปที ่3.7 การสื่อสารแบบ 1-wire เป็นระบบบัสข้อมูลแบบ Half-duplex นั้นคือสามารถ
สื่อสารได้ 2 ทิศทาง แต่ไม่สามารถรับ และส่งข้อมูลพร้อมกันในช่วงเวลาเดียวกันได้ ระบบบัสมีการ
ท างานเป็นแบบ Master/Slave โดยอุปกรณ์ Master จะเป็นตัวควบคุมสถานะ และจังหวะการรับส่ง
ของบัสข้อมูล ในขณะที่อุปกรณ์ Slave จะท างานตามการควบคุมของอุปกรณ์ Master เท่านั้น 
ในการใช้งานบัสแบบ 1 wire นี้ สายสัญญาณข้อมูล DQ จะต้องมีสภาวะปกติที่ลอจิกสูง สามารถท า
ได้โดยการต่อตัวต้านทานประมาณ 5 กิโลโอห์ม พูลอัปไว้กับไฟเลี้ยง หรือในกรณีที่ใช้บัสแบบ 1 wire 
ต่อร่วมกับอุปกรณ์ DS18S20 หลายตัว ก็สามารถท าได้ดังแสดงในรูปที่ 3.8 

 

รูปที่3.8 การต่อใช้งาน DS18B20 

ในการเขียนข้อมูลแบ่งออกเป็น 2 ชนิดคือการเขียนข้อมูล “0” และการเขียนข้อมูล “1” ดัง
แสดงในรูปที่ 3.9 การเขียนข้อมูลลง DS18S20 ต้องใช้ช่วงเวลาของไทม์สล๊อตอย่างต่ า 60 usec และ
ต้องมีช่วงเวลาระหว่างไทม์สล๊อตอย่างต่ า 1 usec 
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การเขียนข้อมูลทั้ง 2 ชนิด เริม่แรกอุปกรณ์ Master ต้องดึงสัญญาณบนบัส 1-wire ลงมาให้
อยู่ในสถานะลอจิกต่ าก่อน ในกรณีท่ีต้องการเขียนข้อมูล “0” ลงใน DS18S20 อุปกรณ์ Master ต้อง
ดึงสัญญาณบนบัสให้เป็นลอจิกต่ าต่อ จนกว่าจะครบช่วงเวลาไทม์สล๊อต (อย่างต่ า 60 usec) ส่วนใน
กรณีท่ีต้องการเขียนข้อมูล “1” ลง DS18S20 อุปกรณ์ Master ต้องปล่อยบัส เพ่ือให้บัสกลับไปอยู่ใน
สถานะลอจิกสูงก่อนการ Sampling ของ DS18S20 ซึ่งจะอยู่ในช่วง 15 usec-60 usec หลังจากท่ี
อุปกรณ์ Master ดึงสัญญาณบัส 1-wire ลงมาในการอ่านค่าภายใน SRAM ของ DS18S20 สามารถ
ท าได้ก็ต่อเมื่ออุปกรณ์ Master ได้เขียนข้อมูลเพ่ือขอท าการอ่านค่าใน SRAM (Read Scratchpad) 
ซึ่งมคี่าเป็น 0xBE ลงไปที่ DS18S20 เสียก่อน จากนั้นจึงเริ่มอ่านข้อมูลจากบัส 1-wire โดยไทม์สล๊อต
ของการอ่านต้องมีช่วงเวลาอย่างต่ า 60 usec และต้องมีช่วงเวลาระหว่างไทม์สล๊อตอย่างต่ า 1 usec
ดังแสดงในรูปที่ 3.9 

รูปที่ 3.9 การเขียนข้อมูลจาก DS18B20 

 
การอ่านข้อมูลจากบัส 1-wire เริ่มแรกอุปกรณ์ Master จะต้องดึงบัส 1-wire ลงให้อยู่ใน

สถานะลอจิกต่ าเป็นช่วงเวลาอย่างน้อย 1 usec จากนั้นจึงค่อยปล่อยบัส ในกรณีที่ DS18S20 ส่ง
ข้อมูล “0” DS18S20 จะดึงบัสให้เป็นลอจิกต่ าจนจนกว่าจะสิ้นสุดไทม์สล๊อตถึงจึงจะปล่อยบัสให้
กลับไปอยู่ในสถานะลอจิกสูง ส่วนในกรณีที่ DS18S20 ส่งข้อมูล “1” DS18S20 จะปล่อยบัสให้อยู่ใน
สภานะลอจิกสูงตลอด ในการ Sample เพ่ือรับข้อมูลจาก DS18S20 ควรท าภายใน 15 usec 
หลังจากจุดเริ่มของไทม์สล๊อต 
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รปูที ่3.10 การหาข้อมลูจาก DS18B20 

ขั้นตอนการใชง้าน DS18S20 ม ี3 ขัน้ตอนดว้ยกนัคือ  
           1.Initialization  
           2.ROMCommand  
           3.DS18S20FunctionCommand 

ขั้นตอนการอ่านค่าอุณหภูมิจาก DS18S20นั้น แบ่งออกเป็น 2 ขั้นตอนใหญ่ ๆ คือ 
Converting Temperature ซึ่งเป็นการแปลงอุณหภูมิให้อยู่ในรูปข้อมูลดิจิตอลเก็บไว้ใน 
Scratchpad และ Read Scratchpad ซึ่งเป็นการอ่านข้อมูลที่เก็บใน Scratchpad นั้นออกมา ดัง
แสดงในรูปที่ 11 จะเห็นได้ว่าไมโครคอนโทรเลอร์ซึ่งเป็นอุปกรณ์ Master จะต้องท าการ 
Initialization จากนั้นจึงค่อยค าสั่ง SKIP ROM [CCh] ซึ่งเป็น ROM Command ที่ใช้ในกรณีที่ต่อใช้
งาน DS18S20 เพียงตัวเดียวจากนั้นจึงค่อยส่ง Function Command CONVERT T [44h] เพ่ือสั่งให้ 
DS18S20 ท าการแปลงอุณหภูมิให้อยู่ในรูปแบบดิจิตอลและเก็บไว้ใน Scratchpad กระบวนการ
แปลงนี้จะใช้เวลาประมาณ 750ms ซึ่งเราสามารถตรวจสอบสถานการณ์แปลงข้อมูลได้จากการเช็ค
สถานะของบัส 1-wire ในกรณีที่ DS18S20 ยังท าการแปลงข้อมูลอยู่บัส 1-wire จะมีสถานะเป็น
ลอจิกต่ า แต่ถ้า DS18S20 ได้ท าการแปลงข้อมูลเสร็จเรียบร้อยแล้วบัส 1-wire จะกลับมาอยู่ใน
สถานะปกติคือลอจิกสูง 
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เมื่อ DS18S20 แปลงข้อมูลอุณหภูมิเป็นดิจิตอลเก็บไว้ใน Scratchpad แล้ว
ไมโครคอนโทรลเลอร์สามารถอ่านข้อมูลภายใน Scratchpad นั้นโดยท าการ Initialization บัส 
 1-wire อีกครั้ง จากนั้นจึงส่งค าสั่ง SKIP ROM ซึ่งเป็น ROM Command และส่งค าสั่ง READ 
SCRATCHPAD  ซึ่งเป็น Function Command เพ่ือขออ่านข้อมูล Scratchpad ภายใน DS18S20 
จากนั้นไมโครคอนโทรลเลอร์จึงค่อยท าการอ่านข้อมูลภายใน Scratchpad ของ DS18S20 มาทีละ
ไบต์จนครบ 9 ไบต์ และแสดงผลข้อมูลอุณหภูมิที่อยู่ซึ่งเป็นข้อมูลในไบต์แรก และไบต์ 2 ที่อ่านมาจาก 
Scratchpad นั้นออกมาทางพอร์ตอนุกรม 
 
3.3.2   บอร์ดไมโครคอนโทรลเลอร์ Arduino รุน่ Arduino UNO R3 

 

รูปที่ 3.12   บอร์ดไมโครคอนโทรเลอร์ Aduino UNO R3 

 Arduino UNO R3 เป็น ไมโครคอนโทรลเลอร์ board ที่ใช้ ATmega328 เป็น MCU หลัก 
ซึ่งตัวนี้จะมีขา Digital 14 ขา อินพุท/เอาท์พุท (สามารถท าเป็น PWM ได้ถึง 6 ขา) และมีขา Analog 
อินพุทได้อีก 6 ขา, รันที่ความถี่ 16 MHz มี USB Connector และ Power Jack DC ซึ่ง Concept 
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ของ Arduino Board นี้ท ามาเพ่ือความสะดวก ง่ายในการเชื่อมต่อเข้ากับคอมพิวเตอร์ สามารถต่อ 
USB เข้ากับช่องคอมพอร์ตก็สามารถ Run โปรแกรมท่ี Board ได ้มีรายละเอียดโดยสรุปดังนี้ 

บอร์ด Arduino UNO R3 มีคุณสมบัติดังนี้ 

 ไมโครคอนโทรลเลอร์    ATmega328 
Operating Voltage    5V 
Input Voltage (recommended)  7-12V 
Input Voltage (limits)    6-20V 
Digital I/O Pins    14 
Analog Input Pins    6 
DC Current per I/O Pin   40 mA 
DC Current for 3.3V Pin   50 mA 
Flash Memory  32 KB (ATmega328) of which 0.5 KB used by bootloader 
SRAM      2 KB (ATmega328) 
EEPROM     1 KB (ATmega328) 
Clock Speed     16 MHz 

 

รูปที่ 3.13 โครงสร้างของบอร์ด Arduino UNO R3 

การใชง้านบอรด์ Arduino UNO R3 
 

1.ก่อนการติดตั้งเข้าไปดูใน Device Manager ว่ามีรายการอะไรอยู่บ้าง 
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รูปที่ 3.14 การใช้งานบอร์ด Arduino UNO R3 
2. เสียบสาย USB (ซึ่งต่ออยู่กับบอร์ด Arduino) เข้าเครื่องคอมพิวเตอร์ 
 

 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 3.15 เสียบสาย USB (ซึ่งต่ออยู่กับบอร์ด Arduino) 
จะมีรายการปรากฎขึ้นเพ่ิมเติม (ซึ่งตอนที่ไม่ได้เสียบ USB ไม่มีรายการนี้) ดังรูป (Unknown Device) 
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รูปที่ 3.16 ดู driver  Arduino UNO R3 

3. คลิกขวาที่รายการดังกล่าว เลือก Update Driver Software...  
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่ 3.17 Update Driver 
 
 

4. คลิก Browse my computer for driver software 
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รูปที่ 3.18 update driver software  

 
5. คลิก Browse เพ่ือหาต าแหน่งเก็บไฟล์ Driver 

 
รูปที่ 3.19 Browse เพ่ือหาต าแหน่งเก็บไฟล์ Driver 
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6. ต าแหน่ง Driver จะอยู่ในโฟลเดอร์โปรแกรม Arduino ดังรูป จากนั้นคลิก Next 

 
รูปที่ 3.20 ต าแหน่ง Driver 

 
รูปที่ 3.21 next install program  
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รูปที่ 3.22 รอลงโปรแกรม  

 
 
 
7. คลิก Install เพ่ือติดตั้ง Driver ลง Window  
 

 
รูปที่ 3.23 Install เพ่ือติดตั้ง Driver ลง Window 
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8. เสร็จสิ้นการติดตั้ง 

 
รูปที่ 3.24 เสร็จสิ้นการติดตั้ง 

 
9. เมื่อไปดูใน Device Manager จะเห็นรายการ Arduino UNO พร้อมหมายเลข Com พอร์ตที่ใช้ใน
การเชื่อมต่อ 

 
รูปที่ 3.25 ดูใน Device Manager 
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เริ่มตน้การทดลอง 
ก่อนที่จะเริ่มต้นการทดลองทุกครั้ง (หลังจากเปิดเครื่องคอมพิวเตอร์ใหม่) จ าเป็นต้องมีการตั้งค่าบอร์ด
ที่ใช้งานโดยมีการตั้งค่า 3 รายการคือ 
1. บอร์ดท่ีใช้งาน ในที่นี้ใช้บอร์ด Arduino UNO R3 ดังนั้นต้องเลือกรายการ Arduino UNO ดังรูป 

 
รูปที่ 3.26 เลือกชนิด Arduino 

 
2. COM พอร์ตที่บอร์ดท าการเชื่อมต่อ โดยดูได้จาก Device Manager ดังที่ได้กล่าวมาแล้วข้างต้น 
 

 
 

รูปที่ 3.27 เลือกport 
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3. เลือกชนิดเครื่องโปรแกรม เนื่องจากบูตโหลดเดอร์ของบอร์ดได้จ าลองตัวเองเป็น AVRISP mkII 
ดังนั้นเครื่องโปรแกรมจึงต้องเลือกรายการดังรูป 
 

 
รูปที่ 3.28 เลือกชนิด Programmer 

ส าหรับการตั้งค่าให้แสดงต าแหน่งของไฟล์ภาษาเครื่อง เพื่อจะน าไปใช้ในการจ าลองการท างานจะต้อง
ตั้งค่าที่ Preferences ดังรูป 

 
รูปที่ 3.29 ตั้งค่าที่ Preferences 
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รูปที่ 3.30 หน้าต่างตั้งค่า 

 
 

เริ่มทดลองจากตัวอย่างไฟกระพริบ Blink โดยเรียกไฟล์ตัวอย่างดังรูป 
 

 
รูปที่ 3.31 ทดลองจากตัวอย่าง 

ทดลองแปลงไฟล์โดยกดท่ีไอคอนเครื่องหมายถูกดังรูป  แต่หากต้องการอัพโหลดลงบอร์ดจริงด้วยให้
กดท่ีปุ่มหัวลูกศร (ปุ่มถัดไป) 
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รูปที่ 3.32 แสดงสถานะ 

3.3.3   จอแสดงผล LCD 
 
 
 
 
 
 
 
 
 
 

รูปที่ 3.33 จอแสดงผล LCD 
 
ลักษณะและต าแหนง่ของขา LCD 
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รูปที่ 3.34 ต าแหน่งขาของ LCD 
 
ต าแหนง่ของขาและหนา้ที่การใช้งานของ LCD โมดลู 
 
ตารางที ่3.1 ต าแหน่งของขาและหน้าที่การใช้งานของ LCD 
Pin No. Symbol Description Level Function 

1 VSS Ground - 0V    Ground 
2 VDD  Power Supply - +5V  ต่อกับแรงดันไฟเลี้ยง +5V 
3 VO LCD Contr - -  ต่อกับแรงดันเพื่อปรับความเข้มของการแสดงผล 
4 RS Register Select H/L   RS = 0 หมายถึงต้องการติดต่อกับรีจิสเตอร์ค าสั่ง (Instruction Register)  

  RS = 1 หมายถึงต้องการติดต่อกับรีจิสเตอร์ข้อมูล (Data Register) 
5 R/W Read/Write H/L   R/W = 0 หมายถึงต้องการเขียนข้อมูลไปยัง LCD โมดูล  

  R/W = 1 หมายถึงต้องการอ่านข้อมูลจาก LCD โมดูล 
6 E Enable H, H->L   Enable Signal 

7 - 14 DB0-DB7 Data Bus H/L   Data Bus Line 
15 A Back Light A -   Back Light +5V (ส าหรับรุ่นที่มี  Back Light) 
16 K Back Light K -   Back Light 0V (ส าหรับรุ่นที่มี  Back Light) 

 

   

 

 

 

 

การต่อ LCD เขา้กบับอรด์ Arduino 
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รูปที่ 3.35 การต่อ LCD เข้ากับบอร์ด Arduino 

สามารถต่อบอร์ด Aduino กับ LCD ได้ดังนี้ 
-   LCD RS ต่อกับ Digital 2 
-   LCD Enable ต่อกับ Digital 4 
-   LCD D4 ต่อกับ Digital 5 
-   LCD D5 ต่อกับ Digital 15 
-   LCD D6 ต่อกับ Digital 16 
-   LCD D7 ต่อกับ Digital 17 
-   LCD Gnd และ LCD R/W ต่อเข้า GND  
-   LCD Vcc ต่อเข้า 5V 
-   LCD VO ต่อกับ Digital 3 
 
 
 
 
3.3.4 วงจรเสยีงแจง้เตือน 
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รูปที่ 3.36 วงจรแจ้งเตือน 

 
วงจรเสียงไซเรน 6 เสียงชุดนี้เป็นวงจรก าเนิดเสียงชนิดหนึ่งซึ่งใช้หลักการทางดิจิตอลเมโมรี่

เป็นสัญญาณทางดิจิตอลและโปรแกรมเข้าไปในตัวไอซี ซึ่งขบวนการทั้งหมดนี้จะท ามาจากทางโรงงาน
ผู้ผลิตไอซี เราจะมาเปลี่ยนแปลงโปรแกรมเหล่านี้ไม่ได้ วงจรนี้เหมาะส าหรับน าไปใช้ติดกับรถของเล่น
ขนาดเล็ก ข้อมูลทางด้านเทคนิค: - ใช้แหล่งจ่ายไฟขนาด 9 โวลท์ดีซี - กินกระแสสูงสุดประมาณ 105 
มิลลิแอมป์ - ขนาดแผ่นวงจรพิมพ์ : 1.13 x 1.00 นิ้ว 

 
 

3.3.5 โซลา่เซลล ์

 
รูปที่ 3.37 โซล่าเซลล ์

หลักการท างานของโซลา่เซลล์ 
โซล่าเซลล์เป็นสิ่งประดิษฐ์กรรมทาง electronic ที่สร้างขึ้นเพ่ือเป็นอุปกรณ์ส าหรับเปลี่ยน

พลังงานแสงอาทิตย์ให้เป็นพลังงาน ไฟฟ้า โดยการน าสารกึ่งตัวน า เช่น ซิลิกอน ซึ่งมีราคาถูกที่สุดและ
มีมากท่ีสุดบนพื้นโลกมาผ่านกระบวนการทางวิทยาศาสตร์ เพ่ือผลิตให้เป็นแผ่นบางบริสุทธิ์ และทันที
ที่แสงตกกระทบบนแผ่นเซลล์ รังสีของแสงที่มีอนุภาคของพลังงานประกอบที่เรียกว่า โฟตอน 
(Proton) จะถ่ายเทพลังงานให้กับอิเล็กตรอน (Electron) ในสารกึ่งตัวน าจนมีพลังงานมากพอที่จะ

 

 

 

 

 

 

 

 

http://www.premiumsolarcell.com/%e0%b8%9a%e0%b8%97%e0%b8%84%e0%b8%a7%e0%b8%b2%e0%b8%a1%e0%b9%82%e0%b8%8b%e0%b8%a5%e0%b9%88%e0%b8%b2%e0%b9%80%e0%b8%8b%e0%b8%a5%e0%b8%a5%e0%b9%8c/%e0%b8%97%e0%b8%b3%e0%b8%87%e0%b8%b2%e0%b8%99%e0%b8%82%e0%b8%ad%e0%b8%87%e0%b9%82%e0%b8%8b%e0%b8%a5%e0%b9%88%e0%b8%b2%e0%b9%80%e0%b8%8b%e0%b8%a5%e0%b8%a5.html
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กระโดดออกมาจากแรงดึงดูดของอะตอม (atom) และเคลื่อนที่ได้อย่างอิสระ ดังนั้นเมื่ออิเล็กตรอน
เคลื่อนที่ครบวงจรจะท าให้เกิดไฟฟ้ากระแสตรงขึ้นวัสดุส าคัญท่ีใช้ท าโซล่าเซลล์์ ได้แก่ สารซิลิคอน (Si) 
ซึ่งเป็นสารชนิดเดียวกับท่ีใช้ท าชิพในคอมพิวเตอร์ และเครื่องอิเล็กทรอนิกส์ ซิลิคอนเป็นสารซึ่งไม่เป็น
พิษ มีการน ามาผลิตโซล่าเซลล์ใช้กันอย่างแพร่หลายเพราะมีราคาถูก คงทน และเชื่อถือได้ นอกจากนี้
ยังมีวัสดุชนิดอ่ืนที่สามารถน ามาผลิตโซล่าเซลล์ได้ เช่น แกลเลียมอาเซไนด์ CIS และ แคดเมียมเทล
เลอไรด์ แต่ยังมีราคาสูง และบางชนิดยังไม่มีการพิสูจน์เรื่องอายุการใช้งานว่าสามารถใช้งานได้นาน 
ข้อเสียของ Si : การท าให้บริสุทธิ์และอยู่ในรูปสารที่พร้อมจะท าเซลล์ฯ มีราคาแพง และ แตกหักง่าย
ในขบวนการผลิต 
การท างานของโซล่าเซลล์ เป็นขบวนการเปลี่ยนพลังงานแสงเป็นกระแสไฟฟ้าได้โดยตรง โดยเมื่อแสง
ซึ่งเป็นคลื่นแม่เหล็กไฟฟ้าและมีพลังงานกระทบกับสารกึ่งตัวน า จะเกิดการถ่ายทอดพลังงานระหว่าง
กัน พลังงานจากแสงจะท าให้เกิดการเคลื่อนที่ของกระแสไฟฟ้า (อิเลคตรอน) ขึ้นในสารกึ่งตัวน า จึง
สามารถต่อกระแสไฟฟ้าดังกล่าวไปใช้งานได้ n– type ซิลิคอน ซึ่งอยู่ด้านหน้าของเซลล์ คือ สารกึ่ง
ตัวน าที่ได้การโดปปิ้งด้วยสารฟอสฟอรัส มีคุณสมบัติเป็นตัวให้อิเล็กตรอนเมื่อรับพลังงานจาก
แสงอาทิตย์ p – type ซิลิคอน คือสารกึ่งตัวน าที่ได้การโดปปิ้งด้วยสารโบรอน ท าให้โครงสร้างของ
อะตอมสูญเสียอิเล็กตรอน (โฮล) เมื่อรับพลังงาน จากแสงอาทิตย์จะท าหน้าที่เป็นตัวรับอิเล็กตรอน 
เมื่อน าซิลิคอนทั้ง 2 ชนิด มาประกบต่อกันด้วย p – n junction จึงท าให้เกิดเป็น ” โซล่าเซลล์ ” ใน
สภาวะที่ยังไม่มีแสงแดด n – type ซิลิคอนซึ่งอยู่ด้านหน้าของเซลล์ ส่วนประกอบส่วนใหญ่พร้อมจะ
ให้อิเล็กตรอน แต่ก็ยังมีโฮลปะปนอยู่บ้างเล็กน้อย ด้านหน้าของ n – type จะมีแถบโลหะเรียกว่า 
Front Electrode ท าหน้าที่เป็นตัวรับอิเล็กตรอน ส่วน p – type ซิลิคอนซึ่งอยู่ด้านหลังของเซลล  ์ 
โครงสร้างส่วนใหญ่เป็นโฮล แต่ยังคงมีอิเล็กตรอนปะปนบ้างเล็กน้อย ด้านหลังของ p – type ซิลิคอน
จะมีแถบโลหะเรียกว่า Back Electrode ท าหน้าที่เป็นตัวรวบรวมโฮล 

 
รูปที่ 3.38 แสดง type และ การถ่ายเทพลังงาน 

เมื่อมีแสงอาทิตย์ตกกระทบ แสงอาทิตย์จะถ่ายเทพลังงานให้กับอิเล็กตรอนและโฮล ท าให้เกิดการ
เคลื่อนไหว เมื่อพลังสูงพอทั้งอิเล็กตรอนและโฮลจะวิ่งเข้าหาเพ่ือจับคู่กัน อิเล็กตรอนจะวิ่งไปยังชั้น n 
– type และโฮลจะวิ่งไปยังชั้น p type 
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เมื่อมีแสงอาทิตย์ตกกระทบ แสงอาทิตย์จะถ่ายเทพลังงานให้กับอิเล็กตรอนและโฮล ท าให้เกิดการ
เคลื่อนไหว เมื่อพลังสูงพอทั้งอิเล็กตรอนและโฮลจะวิ่งเข้าหาเพ่ือจับคู่กัน อิเล็กตรอนจะวิ่งไปยังชั้น n 
– type และโฮลจะวิ่งไปยังชั้น p type อิเล็กตรอนวิ่งไปรวมกันที่ Front Electrode และโฮลวิ่งไป
รวมกันที่ Back Electrode เมื่อมีการต่อวงจรไฟฟ้าจาก Front Electrode และ Back Elec trode 
ให้ครบวงจร ก็จะเกิดกระแสไฟฟ้าขึ้น เนื่องจากทั้งอิเล็กตรอนและโฮลจะวิ่งเพ่ือจับคู่กันตัวแปรที่
ส าคัญที่มีส่วนท าให้โซล่าเซลล์มีประสิทธิภาพการท างานในแต่ละ พ้ืนที่ต่างกัน และมีความส าคัญใน
การพิจารณาน าไปใช้ในแต่ละพ้ืนที่ ตลอดจนการน าไปค านวณระบบหรือค านวณจ านวนแผง
แสงอาทิตย์ที่ต้องใช้ในแต่ละ พ้ืนที่ คือความเข้มของแสง และอุณหภูมิ 

กระแสไฟ (Current) จะเป็นสัดส่วนโดยตรงกับความเข้มของแสง หมายความว่าเมื่อความ
เข้มของแสงสูง กระแสที่ได้จากโซล่าเซลล์ก็จะสูงขึ้น ในขณะที่แรงดันไฟฟ้าหรือโวลต์แทบจะไม่แปรไป
ตามความเข้มของแสงมากนัก ความเข้มของแสงที่ใช้วัดเป็นมาตรฐานคือ ความเข้มของแสงที่วัดบน
พ้ืนโลกในสภาพอากาศปลอดโปร่ง ปราศจากเมฆหมอกและวัดที่ระดับน้ าทะเลในสภาพที่แสงอาทิตย์
ตั้งฉากกับพ้ืนโลก ซึ่งความเข้ม ของแสงจะมีค่าเท่ากับ 100 mW ต่อ ตร.ซม. หรือ 1,000 W ต่อ ตร.
เมตร ซึ่งมีค่าเท่ากับ AM 1.5 (Air Mass 1.5) และถ้าแสงอาทิตย์ท ามุม 60 องศากับพ้ืนโลกความเข้ม
ของแสง จะมีค่าเท่ากับประมาณ 75 mW ต่อ ตร.ซม. หรือ 750 W ต่อ ตร.เมตร ซึ่งมีค่าเท่ากับ AM2 
กรณีของแผงโซล่าเซลล์นั้นจะใช้ค่า AM 1.5 เป็นมาตรฐานในการวัดประสิทธิภาพของแผง 

กระแสไฟ (Current) จะไมแ่ปรตามอุณหภูมิที่เปลี่ยนแปลงไป ในขณะที่แรงดันไฟฟ้า (โวลท์) 
จะลดลงเมื่ออุณหภูมิสูงขึ้น ซึ่งโดยเฉลี่ยแล้วทุกๆ 1 องศาที่เพ่ิมขึ้น จะท าให้แรงดันไฟฟ้าลดลง 0.5% 
และในกรณีของแผงโซล่าเซลล์มาตรฐานที่ใช้ก าหนดประสิทธิภาพของแผงแสง อาทิตย์คือ ณ อุณหภูมิ 
25 องศา C เช่น ก าหนดไว้ว่าแผงแสงอาทิตย์มีแรงดันไฟฟ้าที่วงจรเปิด (Open Circuit Voltage หรือ 
V oc) ที่ 21 V ณ อุณหภูมิ 25 องศา C ก็จะหมายความว่า แรงดันไฟฟ้าที่จะได้จากแผงแสงอาทิตย์ 
เมื่อยังไม่ได้ต่อกับอุปกรณ์ไฟฟ้า ณ อุณหภูมิ 25 องศา C จะเท่ากับ 21 V ถ้าอุณหภูมิสูงกว่า 25 องศา 
C เช่น อุณหภูมิ 30 องศา C จะท าให้แรงดันไฟฟ้าของแผงแสงอาทิตย์ลดลง 2.5% (0.5% x 5 องศา 
C) นั่นคือ แรงดันของแผงแสงอาทิตย์ที่ V oc จะลดลง 0.525 V (21 V x 2.5%) เหลือเพียง 20.475 
V (21V ? 0.525V) สรุปได้ว่า เมื่ออุณหภูมิสูงขึ้น แรงดันไฟฟ้าก็จะลดลง ซึ่งมีผลท าให้ก าลังไฟฟ้า
สูงสุดของแผงแสงอาทิตย์ลดลงด้วย 
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3.3.6 Xbee 

 
รูปที่ 3.39 Xbee Pro 

Xbee เป็นอุปกรณ์ที่มี ไมโครคอนโทรลเลอร์ และ RF IC อยู่ภายใน (อ้างอิงได้จาก
Schematic) ท าหน้าที่เป็น อุปกรณ์ transceiver (อุปกรณ์รับ-ส่งสัญญาณ) แบบ Half Duplex ย่าน
ความถี่ 2.4 GHz มีการจัดการโดยใช้พลังงานต่ า ใช้งานง่าย มี interface ที่ใช้รับและส่งข้อมูลกับ 
Xbee เป็น UART (TTL) ซึ่งส าหรับทางด้านไมโครคอนโทรลเลอร์ สามารถน าขาที่ใช้ติดต่อสื่อสาร 
UART ของ Xbee ต่อเข้ากับ UART ของ ไมโครคอนโทรลเลอร์ ได้โดยตรง 

Xbee สามารถใช้งานตามมาตรฐาน Zigbee ได้ โดยที่ไม่ต้องเขียนโปรแกรมสร้าง เครือข่าย 
Zigbee เลย เพราะว่าทางผู้ผลิตได้จัดท า firmware ที่จะโหลดเข้าไปในตัว Xbee ให้สามารถ set 
parameter ผ่าน software interface (X-CTU หรือโปรแกรมที่เขียนขึ้นเอง) , ผ่านทาง At 
command (เหมือนกับการควบคุม GSM Module ) โดยใช้ Hyper terminal หรือ ผ่านทางการ
รับส่งข้อมูลด้วยไมโครคอนโทรลเลอร์ ได้อย่างง่ายดาย โดยเมื่อ set Xbee ให้ท างานเป็นอุปกรณ์ใน
เครือข่าย Zigbee แล้ว และจะเรียก Xbee แต่ละตัวว่าเป็น Node  

Firmware ที่ใช้กับ Xbee จะใช้โหลดผ่านโปรแกรม X-CTU ทั้ง นี้ Xbee แต่ละรุ่น จะ
สามารถ Setting Function การใช้งานได้มากมาย ท าให้ Firmware ที่จะต้องโหลดเข้าไปนั้น มี
มากมายหลายแบบ และต้องเลือกให้เหมาะสมกับการใช้งาน  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

http://www.thaieasyelec.com/Wireless-Module/Zigbee802154
http://elearning.northcm.ac.th/it/lesson6-1.asp
http://www.thaieasyelec.com/electronics-in-chapter/UART-TTL-RS232-MAX232-MAX3232.html
http://www.ett.co.th/product/intf/ET-GSM-SIM300CZ-V1.0.html
http://www.adisak51.com/page16.html
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3.4 การเขยีนโปรแกรมของระบบตรวจวดัอุณหภมูิอตัโนมตัโิดยผ่านเครอืขา่ย xbee 
โดยมแีหลง่จ่ายเปน็โซล่าเซลล์ 

 
3.4.1 แผนผังการท างานของโปรแกรม (Flow chart)  
 
ภาคส่ง 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 3.40 แผนผังการท างานของภาคส่ง 
 

START 

STOP 

รับข้อมูลจากเซนเซอร์ 
 

PRINT “-” 
 

PRINT ข้อมูลที่
รับจากเซนเซอร์ 
 

Delay 2 s 
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ภาครบั 

 

 

 

 

                    

           YES 

 

      

                                                                            NO                                                

 

 

 

 

 

 

                                                                                                                           NO 

 

 

                                                                       YES 

                                                   

 

 

 

 

 รูปที่ 3.41 แผนผังการท างานของภาครับ 

รอรับขอ้มูล 

START 

แสดงค่าอุณหภูมิท่ีรับมาได ้ท่ีจอ LCD 

ถา้อุณหภูมิ 
>=31? 

ปิดเสียงแจง้เตือน 

เปิดเสียงแจง้เตือน 

 

มีขอ้มูลเขา้มา ? 

Byte==-1 
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การรับข้อมูลอุณหภูมิ 

 

 

 

 

 

 

 

                                                                                                                                    NO 

 

                                                                                                           

                                                                               YES 

 

 

 

 

                                                           NO 

 

                                                                                                   YES    

 

 

 

 

 

 

รูปที่ 3.42 แผนผังการท างานของการรับข้อมลูอณุหภมูิ 

ค่าอุณภูมิท่ีรับมา 
= “ - “? 

รอรับขอ้มูล 

START 

i = i+1 

i = 1 ? 

เก็บค่าอุณภูมิหลกัสิบในตวัแปรT(0)

และ i = i+1 

A 

B G 
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                                                                                                                           NO 

 

 

                                                                      YES 

 

 

 

 

 

 

                                                                                                                 NO 

 

 

                                                                             YES 

 

 

 

 

 

 

รูปที่ 3.43 แผนผังการท างานของการรับข้อมูลอุณหภูมิ (ต่อ) 

อุณภูมิหลกัสิบ 

>=3 
L = 0 

A 

L = 1 

i = 2 ? 

B 

 

เก็บค่าอุณภูมิหลกัหน่วยในตวัแปร

T(1)และ i = i+1 

C 
E 

F 
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                                                                                                                             NO 

 

 

                                                                 YES NO 

 

YES 

 

 

 

 

 

                                                                                                                 NO 

 

                                                                             YES 

 

 

 

 

 

 

รูปที่ 3.44 แผนผังการท างานของการรับข้อมลูอณุหภมูิ (ต่อ) 

C 

อุณภูมิหลกัหน่วย 
>=1 

L = 0 

L = L+1 

i = 3 ? 

 

เก็บจุดทศนิยมในตวัแปรT(2) 
และ i = i+1 

D 

F 

G 

L=1? 
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                                                                                                                  NO 

 

                                                                       YES 

 

 

 

 

 

 

 

 

 

                                                     NO 

 

 

                                                                                          YES 

 

 

 

 
 

รูปที่ 3.45 แผนผังการท างานของการรับข้อมลูอณุหภมูิ (ต่อ) 
 
 

D 

i = 4 ? 

เก็บจุดทศนิยมต าปหน่งท่ี1ในตวัแปร
T(3) 

และ i = i+1 

 

i = 5 ? 

เก็บจุดทศนิยมต าปหน่งท่ี2ในตวัแปร
T(4)และ i = 0 

 

E 
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3.4.2   Code program และค าอธบิาย 
ภาคสง่ 
#include <OneWire.h> //ในการเขียนโปรแกรมส าหรับ Arduino เพ่ือ

เชื่อมต่อกับไอซี DS18B20 สามารถใช้ไลบรารี่ 
"OneWire.h" ของ Arduino ซึ่งท าให้สะดวกใน
การเขียนโปรแกรม เช่น เพ่ือการค้นหาหลายเลข 
(64-bit code) ของอุปกรณ์ท่ีต่ออยู่กับบัส 1-
Wire การสั่งให้ไอซีตามหมายเลขอุปกรณ์อ่าน
และแปลงค่าอุณหภูมิ 

#include <DallasTemperature.h> 
#define ONE_WIRE_BUS 2 //รับข้อมูล จากเซ็นเซอร์ เข้ามาท่ี pin 

D2 
OneWire oneWire(ONE_WIRE_BUS); 
DallasTemperature sensors(&oneWire); 
 
void setup(void) 
{ 
  Serial.begin(9600);     //เซ็ต Buadrate เริ่มต้น = 9600 
  sensors.begin(); //สั่งให้ เซ็นเซอร์ (DS18B20) เริม

ท างาน 
} 
 
void loop(void) 
{  
  sensors.requestTemperatures();    //รับค่าจากเซ็นเซอร์ (DS18B20)  
  Serial.print("-");      //สั่ง เครื่องหมาย - 
  Serial.println(sensors.getTempCByIndex(0));  //ส่งค่าที่ได้จากเซ็นเซอร์ (DS18B20)  
delay(2000);        //หน่วงเวลา 2วินาที 
} 
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ภาครบั 
#include <LiquidCrystal.h> 
LiquidCrystal lcd(12, 11, 5, 4, 3, 2); 
char T[5]; 
int i=0; 
int l=0; 
void setup() {           //ฟังก์ชั่น ที่มีหน้าที่ set หน้าที่ของแต่ล่ะ pin 
Serial.begin(9600);        //ก าหนด Baud rate โดยตัวเลขที่อยู่ในวงเล็บ

คือค่าความเร็วในการรับ-ส่งข้อมูล (Baud rate) 
lcd.begin(16, 2);        //ชนิดของ LCD แบบ 16 ตัวอักษร 2 บรรทัด 
lcd.print("Temperature");        //สั่ง พิมข้อความ Temperature บน LCD 
pinMode(8,OUTPUT);       //output ออกที่ pin8 
} 
void loop() { 
char byte=Serial.read();      //ประกาศตัวแปร byte = ค่าที่อ่านได้จาก 

DS18B20 (เซ็นต์เซอร์อุณหภูมิ)   ซึ่งการส่ง
ข้อมูลของ DS18B20 จะเรียงล าดับตามนี้ 1.ส่ง"-
" 2.ส่งหลักสิบ 3.ส่งหลักหน่วย 4.ส่งจุดทศนิยม 
5.ทศนิยมต าแหน่งที่ 16.ทศนิยมต าแหน่งที่2 

 
if(byte== -1){         //ถ้ามีมีการส่งข้อมูลค่า xbee ที่ส่งมาจะเป็น -1 
  delay(1); 
} 
else{ 
 
if(byte=='-'){i=i+1;}        //1.รับค่า อันดับแรกได้ - เข้ามา จึงมา เริ่มที่ตรง

นี้   จากนั้น ค่า i จะเป็น 1 
if(i==1){          //2.ถ้า i=1  จะท าการเก็บตัวแปรอะเรย์ ข้อมุลที่

รับได ้(รับหลักสิบ) ไปที่ T(0) จากนั้นเพิ่มให้ i=2  
    T[i-1]=byte; 
    i=i+1; 
    if(byte>='3'){         //2.1แต่ถ้า ค่าที่รับได้มีค่า >=3 จะท าให้ l=1  

ถ้าไม่ใช่ l=0 
      l=1; 
    } 
    else{ 
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      l=0; 
    } 
  } 

if(i==2){         //3. ถ้า i=2  จะท าการเก็บตัวแปรอะเรย์ ข้อมุล
ที่รับได้(รับหลักหน่วย)ไปที่ T(1) จากนั้นเพ่ิมให้ 
i=3 

    T[i-1]=byte; 
    i=i+1; 
    if(byte>='1'){         //3.1ถ้า ค่าท่ีรับมาได้ มีคา่>=1 จะไปดูว่า l มีค่า 

=1 หรือไม่ ถ้าใช่ จะท าให้ l=2 ถ้าไม่ใช่จะท าให้ 
l=0 

      if(l==1){ 
        l=2; 
      } 
      else{l=0;} 
    } 
  } 
if(i==3){           //4. ถ้า i=3  จะท าการเก็บตัวแปรอะเรย์ ข้อมุล

ที่รับ (รับ จุดทศนิยม) ได้ไปที่ T(2) จากนั้นเพ่ิม
ให้ i=4 

    T[i-1]=byte; 
    i=i+1; 
  } 
if(i==4){         //5. ถ้า i=4 จะท าการเก็บตัวแปรอะเรย์ ข้อมุลที่รับ

(ทศนิยมต าแหน่งที่1) ได้ไปที่ T(3) จากนั้นเพิ่มให้ 
i=5 

    T[i-1]=byte; 
    i=i+1; 
  } 

if(i==5){        //6.ถ้า i=5 จะท าการเก็บตัวแปรอะเรย์ ข้อมุลที่รับ
(ทศนิยมต าแหน่งที่2) ได้ไปที่ T(4) จากนั้นเพิ่มให้ 
i=0 

    T[i-1]=byte; 
    i=0; 
    lcd.setCursor(0, 1);      //7.set ต าแหน่งเริ่มต้น lcd ที่คอลัมน์ 1 แถว 2 

จากนั้นแสดง อะเรย์T() ทั้งหมดท่ีเก็บค่าไว้ 
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    lcd.print(T); 
  } 
} 
if(l==2){         //8.ถ้า l=2 ให้ส่ง output ออกท่ี pin8 แต่ถ้า ไม่ใช่ 

ก็ไม่ส่ง ซึ่งในส่วนนี้หมายถึงว่า 
digitalWrite(8,HIGH);      ที ่l=2 ก็คือ อุณภูมิของเราเกิน 31 แล้ว จึงส่ง 

output ออกที่ pin8 เพ่ือให้วงจร Alarm แจ้งเตือน 
} 
else{ 
digitalWrite(8,LOW); 
} 
 
} 
 
3.4.3   การเขยีนโปรแกรม Arduino IDE 
  บอร์ดArduino นั้นต้องเขียนด้วยโปรแกรม Arduino IDE ( Integrated Development 
Environment ) ซึ่งตัวโปรแกรมตัวนี้นั้นถูกพัฒนาต่อมาจากโปรแกรม open source อย่าง 
Processing และ Wiring และด้วยความที่ทั้งตัวโปรแกรม Processing และ Wiring นั้นถูกพัฒนาขึ้น
มาด้วยภาษา JAVA จึงท าให้สามารถใช้งานได้ทั้งบนระบบปฏิบัติการ Windows, Linux และ Mac 
OS ได้ ตัวโปรแกรม Arduino IDE ถูกพัฒนาขึ้นมาเพ่ือให้ใช้งานได้ง่ายสะดวกและลดความซับ ซ้อน
ของการเขียนโปรแกรมในรูปแบบของภาษา C/C++ ให้ดูเรียบง่าย ไม่ซับซ้อน มีค าสั่งและไลบรารี่
เตรียมไว้ให้แล้ว 

 ชนดิของตวัแปรในการเขยีนโปรแกรม 
 Char มีขนาด  8 บิต  ใช้แทนข้อมูล -128 ถึง 127 
 Int  มีขนาด  16 บิต  ใช้แทนข้อมูลจ านวนเต็ม ในช่วง -32,768 ถึง +32,767 
 Long  มีขนาด  32 บิต  ใช้แทนข้อมูลจ านวนเต็ม ในช่วง -2,147,483,648 ถึง 2,147,483,647 
 Float  มีขนาด  32 บิต  ใช้แทนข้อมูลจ านวนจริงในช่วง 10 ยกก าลัง -38 ถึง 10 ยกก าลัง 38 
 Double มีขนาด 64 บิต  ใช้แทนข้อมูลจ านวนจริงในช่วง 10 ยกก าลัง -308 ถึง 10 ยกก าลัง 38 
 

 โครงสรา้งการเขยีนโปแกรม 
 #include<ประกาศLibrary > 
 ประกาศตัวแปรต่างๆ 
 void setup() {  
 
ก าหนดใช้งานportต่างๆ โดยใน Arduino เรียก port ต่างๆเป็นหมายเลข 
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} 
 void loop()  
{ 
 การก าหนดในการใช้ฟังก์ชันต่างๆ 
} 
 
 

 MENU bar ของ Arduino IDE จะประกอบดว้ย 
  1.  Menu File โดยท าหน้าที่บริหารจัดการข้อมูลที่เรียกว่า Sketch File (ไฟล์ที่ท าการเขียน
จะเรียกว่า sketch files) 
  * New : สร้าง Sketch File ใหม่ 
  * Sketchbook : 
  1. Open : เรียก Sketchbook ที่บันทึกไว้ก่อนหน้านี้ 
  2. Example :เปิด Sketchbook ตัวอย่างที่มาจาก Library 
  * Save : บันทึก Sketch File ณ.ปัจจุบัน 
  * Save as : บันทึก Sketch File ในที่ อ่ืนหรือชื่อใหม่ 
  * Upload to I/O board : การ burn สู่ MCU(AVR) หลังจากที่เขียนโปรแกรมเสร็จ 
  * Preference : ตั้งค่าต่าง ๆ ของArduino IDE 
  2.  Edit Menu ท าหน้าที่แก้ไข wording 
 
  * Undo : ยกเลิกค าสั่งหรือการพิมพ์ครั้งล่าสุด 
  * Redo : ท าซ้ าค าสั่งหรือการพิมพ์ครั้งล่าสุด 
  * Cut : ตัดข้อความไว้ใน clipboard 
  * Copy : คัดลอกข้อความจาก clipboard 
  * Paste : แปะข้อความจาก clipboard 
  * Select all : เลือก (แรเงา) ข้อความทั้งหมด 
  * Find : ค้นหาข้อความ 
  * Find Next : ค้นหาข้อความถัดไป 
 
  3.  Sketch Menu เป็นเมนูที่ใช้ค าสั่ง Compile ,เพ่ิมLibrary 
  * Verify/Compile : Compile ภาษา c/c++ เป็นภาษา Machine    
  * Stop : หยุดการ Compile 
  * Import Library : เลือก/เพ่ิม Library โดยแทรกในบรรทัดแรก 
  * Show Sketch Folders : ท าการแสดงที่เก็บโปรแกรม 
  * Add File.. : คัดลอก File เลือก/เพ่ิมมาบันทึกรวมใน Folder ปัจจุบัน 
  4. Tools Menu :ใช้จัด code ,เลือกเบอร์ ไมโครคอนโทรลเลอร์ ,เลือก port serial 
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  * Auto Format : จัดวาง code ให้เป็นระเบียบสวยงาม ให้อ่านได้ง่ายโดยแยกสี code ที่
เป้นค าสั่งและตัวแปร 
  * copy to Forum : คัดลอก code ลง clipboard 
  * Archive Sketch : สั่งให้บีบอัด Folder ปัจจุบันเป็นไฟล์บีบอัด มีประโยชน์ในการท า CVS 
  * Board : เลือก Hardware Device ที่ใช้งานกับโปรแกรม เช่น Arduino Nano เป็นต้น 
  * Serial Ports : เลือก port เพ่ือ communication ระหว่าง Hardware Device กับ 
Arduino IDE 
  * Burn Bootloader : เพ่ือท าการ bootloadder ให้ Hardware Device โดยต้องมีเครื่อง 
burn 
 
3.4.4   การโหลดโปรแกรมลงบอร์ด 
1. เปิดโปรแกรม Arduino IDE ที่ได้โหลดมาจาก http://Arduino.cc/en/Main/Software 

2. เมื่อเปิดโปรแกรมแล้วจะพบกับหน้าต่างของ IDE ดังรูป 
 
 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.46 หน้าต่างโปรแกรม 
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3. ไปที่ Tools->Board แล้วเลือกให้ตรงกับบอร์ดที่ใช้งาน ส าหรับ Arduino UNO R3 ให้เลือกบอร์ด 
Arduino UNO 

 

 

 

 

 

 

 

 

 

 

 

 

รูปที่ 3.47 เลือกบอร์ด 
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4. เขียนโปรแกรม 

 
รูปที่ 3.48 การเขียนโปรแกรม 

5. จากนั้นคอมไฟล์โปรแกรมโดยไปท่ี Sketch->Verify / Compile 

 
รูปที่ 3.49 การ compile 
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6. เมื่อคอมไพล์เรียบร้อยจะมีข้อความปรากฎดังรูป 

 
รูปที่ 3.50 การ compile เสร็จเรียบร้อย 

7. ต่อบอร์ด Arduino UNO R3 เข้ากับคอมพิวเตอร์ผ่านทางพอร์ต USB 

 

รูปที่ 3.51 การต่อ Arduino กับ คอมพิวเตอร์ 
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8. จากนั้นให้ไปท่ี Tools->Serial Port และเลือกให้ตรงกับบอร์ด Arduino UNO ที่ใช้งาน (ส าหรับ
บอร์ด Arduino UNO R3 โปรแกรมจะเลือกให้อัตโนมัติ)  

 

 

รูปที่ 3.52 การเลือก serialport 

9. โหลดโปรแกรมเข้าบอร์ด Arduino UNO โดยไปท่ี File->Upload 
10. จากนั้นเปิด Serial Monitor ของ Arduino IDE โดยไปท่ี Tools->Serial Monitor 

 

 

 
 

 

 

 

รุปที่ 3.53 วิธีการแสดงผลที่ serial monitor 
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11. เมื่อเปิด Serial Monitor จะได้ข้อความดังรูป 

 

รุปที่ 3.54 แสดงผลที่ serial monitor 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

บทที ่4 
การทดสอบระบบตรวจวดัอุณหภมูอิตัโนมตัโิดยผ่านเครอืขา่ย xbee 

 
4.1 บทน า 

จาการศึกษาและท าความเข้าใจเกี่ยวกับทฤษฎีพ้ืนฐานในบทที่ 2 และ 3 นั้น ท าให้สามารถ 
เชื่อมต่อวงจรโครงสร้างของระบบเสร็จสมบูรณ์พร้อมที่จะน าไปทดสอบการใช้งานจริงเพ่ือให้บรรลุ
วัตถุประสงค์ของโครงงาน  
 
4.2 การเชือ่มต่อวงจรของระบบในการทดลอง 

4.2.1 เชือ่มต่อ xbee เขา้กับคอมพวิเตอร์ 
 เมื่อท าการเชื่อมต่อวงจรเสร็จเรียบร้อยแล้ว จะสามารถก าหนดค่าพารามิเตอร์ต่างๆได้เช่น 
Baudrate, Destination Address High, Destination Address Low เป็นต้น  
 
 
 
    
 
 
 
 
 
 
 
 
 
 
 
 

 
 

รูปที่ 4.1 การปรับ Baudrate 
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ล าดับต่อมา จะเป็นการเซ็ตพารามิเตอร์ที่ท าให้ Xbee ทั้งภาคส่งภาครับ สามารถท าการเชื่อมต่อกัน
ได้ โดยการเซ็ต DH DL ของภาคส่งให้ตรงกับ SH SL ของภาครับ และ เซ็ต DH DLของภาครับให้ตรง
กับ SH SL ของภาคส่ง (รูปที่4.2) ซึ่งค่า SH SL ของ Xbee แต่ละตัวจะมีค่าต่างกัน สามารถดูได้
ด้านหลังตัว Xbee (รูปที่4.3) 

รูปที่ 4.2 เป็นการเซ็ต Destination Address 

 
รูปที่ 4.3 แสดงค่า SL SH ของ Xbee 
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ค่าSH SL ของ Xbee ทั้งภาครบัและภาคสง่ 
ล าดับต่อมาจะเป็นการเซ็ตพารามิเตอร์ต่างๆ ที่จ าเป็นต้องก าหนดเพื่อใช้ในการส่งข้อมูล 

เช่น การเซ็ตช่องสัญญาณ (รูปที่ 4.4) และ การเซ็ตก าลังงานที่ใช้ในการส่งสัญญาณ (รูปที่ 4.5) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 รูปที่ 4.4 การเซ็ตช่องสัญญาณ ที่ใช้ในการสื่อสาร 
 
 
 
   

         
 

รูปที่ 4.4 การเซ็ตช่องสัญญาณ ที่ใช้ในการสื่อสาร 
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รูปที่ 4.5 การเซ็ตก าลังงานในการส่งข้อมูล (Power Level) 
 
 
4.2.2 เชือ่มต่อวงจรภาคสง่ 
 ท าการเชื่อมต่อบอร์ด Arduino กับเซนเซอร์วัดอุณหภูมิ DS18B20 และเชื่อมต่อบอร์ด 
Arduino กับบอร์ด Xbee Shield ที่ต่อกับตัว Xbee เรียบร้อยแล้ว โดยใช้แบตเตอรี่ 12 v เป็น
แหล่งจ่ายไฟให้กับบอร์ด Arduino และ Xbee ดังรูปที่ 4.6 
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รูปที่ 4.6 แสดงการเชื่อมวงจรภาคส่ง 

 
4.2.3 เชือ่มต่อวงจรภาครบั 

ท าการเชื่อต่อ xbee กับ Arduino เข้ากับคอมพิวเตอร์เพื่อแสดงผลค่าอุณหภูมิที่รับได้ผ่าน
โปรแกรม Arduino  ดังรูป4.7 

 
  
 
 
 
 
 
 
 

 
 

รูปที่ 4.7 เชื่อมต่อภาครับกับคอมพิวเตอร์ 
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4.2.4 เชือ่มต่อวงจรภาครบักบัภาคสง่ 
 ท าการเชื่อมต่อวงจรภาครับกับภาคส่ง ดังรูปที่ 4.8 การท างานของวงจรคือเซนเซอร์ของ
ภาคส่งท าการอ่านอุณหภูมิแล้วส่งค่าอุณหภูมิที่ได้ไปยัง บอร์ด Arduino ภาคส่ง จากนั้นบอร์ด
Arduino จะท าการส่งค่าอุณหภูมิที่ได้ไปที่ Xbee แล้ว Xbee ของภาคส่งท าการส่งค่าอุณหภูมิไปยัง 
Xbee ของภาครับแบบไร้สาย (wireless)  จากนั้น Xbee ของภาครับจะท าการส่งค่าอุณหภูมิที่ได้นี้
ไปแสดงผลที่โปรแกรมArduino ทางหน้าจอคอมพิวเตอร์ ผลอุณหภูมิที่เซนเซอร์ตรวจจับได้แสดงดัง
รูปที่ 4.9 โดยแสดงค่าอุหณภูมิทุกๆ 3 วินาที 

 
   รูปที่ 4.8 แสดงรูปการเชื่อมวงจรภาครับกับภาคส่ง 
 

 
   รูปที่ 4.9 แสดงผลการตรวจจับอุณหภูมิ 
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4.3 ผลการทดสอบโครงสรา้งของระบบตรวจวดัอณุหภมูิอตัโนมตัโิดยผา่นเครือขา่ย xbeeโดยมี
แหล่งจา่ยเปน็โซลา่เซลล ์  
 
4.3.1การทดสอบการท างานของวงจรแจง้เตอืนระบบตรวจวดัอณุหภูม ิ

 
รูปที่ 4.10 ทดสอบวัดภาคส่งที่อุณหภูมิห้อง 

 

 
รูปที่ 4.11 ทดสอบวัดภาคส่งที่อุณหภูมิภายนอก 
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รูปที่ 4.12 ภาครับรับอุณหภูมิจากภายนอกและมีการแจ้งเตือน 

 

 
 

รูปที่ 4.13 ภาคส่งกลับมาวัดในอุณหภูมิห้องเหมือนเดิม 
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หลังจากการทดสอบการท างานของวงจรแจ้งเตือนระบบตรวจวัดอุณหภูมิเสร็จสมบูรณ์แล้ว ต่อไปจะ
เป็นการทดสอบการใช้งานจริงในพ้ืนที่ต่างๆ โดยบริเวณท่ีเลือกใช้ในการในการทดสอบจะมี 2 ลักษณะ
คือ  1.กรณี non line-of-sight (รอบๆอาคารและภายในอาคาร) 

2.กรณี line-of-sight (ภายนอกอาคาร) 
 
4.3.2 การทดสอบกรณีที ่1 non line-of-sight 
 ภาครับจุด R ตั้งอยู่ภายในอาคาร แล้วภาคส่งอยู่บริเวณรอบๆอาคารเรียนรวม 2 
 
      

 
  รูปที่ 4.14 แสดงต าแหน่งทดสอบในบริเวณอาคารเรียนรวมสอง 
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       รูปที ่4.15 ภาคส่งอยู่ที่หน้าห้องศูนย์สหกิจศึกษา 

 
รูปที่ 4.16 ภาคส่งอยู่หน้าห้อง Labcom 5 
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รูปที่ 4.17 ภาครับวางไว้อยู่ที่หน้าห้อง 600 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

96 

 

ผลการทดสอบกรณ ีnon line-of-sight 
 
ตารางที ่4.3.1 การทดสอบภายในอาคารและรอบๆอาคารเสมือนเป็น non line-of-sight 

  

จุดทดสอบ 
ระยะทาง
(m)จาก

อุปกรณ์ตัวส่ง 

จ านวน
ครั้งที่ส่ง 

 

        จ านวนครั้งที่รับได้ 
คิดเป็น % 

 1 
 

2 
 

 3 
 

เฉลี่ย 

A หน้าศูนย์ สหกิจศึกษา 50 10 9 10 10 10 100 
B ทางเดิน รวมหนึ่ง 80 10 6 9 9 8 80 
C ป้ายรถเมล์เรียนรวมสอง 75 10 7 9 9 8.33 83.33 
D ที่จอดรถรวมสอง 60 10 10 8 10 9.33 93.33 
E ชั้นสองรวมสองจุดตรงกัน 5 10 10 9 10 9.66 96.66 
F หน้าห้อง B5205 20 10 10 10 9 9.66 96.66 
G หน้าห้อง B5209 40 10 7 9 10 8.66 86.66 
H หน้าห้อง lab 5 40 10 9 6 6 7 70 

 
น าข้อมูลจากตารางมาพล๊อตกราฟได้ดังนี้ 
 

 
 
 

รูปที่ 4.18 กราฟแสดงความสัมพันธ์ระหว่างสถานที่กับการส่งข้อมูล 
 

ค่า
เฉ

ลี่ย
ทีร่

ับไ
ด้ 

(%
) 

ค่าเฉล่ีย 
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4.3.3 การทดสอบกรณีที ่2 line-of-sight 

 
รูปที่ 4.19 แสดงต าแหน่งทดสอบบริเวณรอบๆอาคารเรียนรวมสอง 

  
หมายเหต:ุ R คือทีเ่ปน็อปุกรณภ์าครบั และ A-I คือจดุทีเ่ปน็อปุกรณภ์าคสง่ 
 
 ท าการทดสอบในแต่ละต าแหน่งตามบริเวณที่ได้ก าหนดไว้ ส าหรับวิธีการส่งข้อมูลจากวงจร
ภาคส่งนั้นจะก าหนดการส่งข้อมูลเป็นครั้งละ 30 วินาที ซึ่งภายใน 30 วินาทีจะส่งข้อมูลทุกๆประมาณ 
3 วินาที เนื่องจากเซ็ตโปรแกรมที่ภาคส่งใช้การหน่วงเวลาเป็น 3 วินาที โดยวงจรภาคส่งเป็นตัวส่ง
ข้อมูลและวงจรภาครับเป็นตัวรับข้อมูลพร้อมทั้งแสดงผลทางโปรแกรม Arduino แล้วบันทึกข้อมูล
จ านวนครั้งที่รับได้ในแต่ละต าแหน่ง 
 

 
รูปที่ 4.20 การวัดในสถานที่จริง 
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ผลการทดสอบกรณ ีline-of-sight 
 
ตารางที ่4.3.2   การทดสอบภายนอกอาคารเสมือนเป็น line-of-sight  

จุดทดสอบ 
ระยะทาง(m)จาก

อุปกรณ์ตัวส่ง 
จ านวนครั้งที่

ส่ง 

จ านวนครั้งที่รับได้ 
คิดเป็น % 

1 2 3 เฉลี่ย 

A 10 10 10 10 10 10 100 
B 20 10 10 10 10 10 100 
C 30 10 10 10 10 10 100 
D 40 10 10 9 9 9.33 93.33 
E 50 10 10 10 8 9.33 93.33 
F 60 10 10 10 10 10 100 
G 70 10 10 10 7 9 90 
H 80 10 10 9 10 9.66 96.66 
I 90 10 10 10 8 9.33 93.33 

 
น าข้อมูลจากตารางมาพล๊อตกราฟได้ดังนี้ 
 

 
   

รปูที่ 4.21 กราฟแสดงความสัมพันธ์ 
 
 
 
 

ค่า
เฉ

ลี่ย
ทีร่

ับไ
ด้ 

(%
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4.3.4 ทดสอบการท างานของเซนเซอรว์ดัอณุหภูมขิองกรณ ีnon line-of-sight 
จะแบ่งเป็น 2 กรณีคือ 

กรณีท่ี 1 ทดสอบช่วงเวลากลางวัน ในเวลา 15.30 น. 
กรณีท่ี 2 ทดสอบช่วงเวลากลางคืน ในเวลา 19.00 น. 

 
 
ตารางที ่4.3.3 ค่าอณุหภูมทิีต่รวจจบัได้ในเวลากลางวนัที่เวลา 15.30 น. ในหนว่ย (องศาเซลเซยีส)  

 จดุทดสอบ 
A B C D E F G H 

ระยะทาง 
(เมตร) 

50 80 75 60 5 20 40 40 

ครัง้ที1่ 32.44 32.81 34.31 33.31 33.00 32.38 32.50 30.81 
ครัง้ที2่ 32.44 32.88 34.63 33.31 32.94 32.19 31.44 30.81 
ครัง้ที3่ 32.50 32.88 34.69 33.19 32.94 32.19 31.44 30.75 
ครัง้ที4่ 32.50 32.94 34.69 33.19 32.94 32.19 31.44 30.75 
ครัง้ที5่ 32.56 33.00 34.75 32.45 32.88 32.19 31.44 30.69 
ครัง้ที6่ 32.63 33.25 34.75 32.31 32.69 32.13 31.50 30.75 
ครัง้ที7่ 32.69 33.44 34.69 32.31 32.69 32.13 31.44 30.69 
ครัง้ที8่ 32.69 33.50 34.75 32.25 32.63 32.13 31.37 30.62 
ครัง้ที9่ 32.75 33.50 34.75 32.06 32.63 32.19 31.37 30.69 
ครัง้ที1่0 32.81 33.44 34.75 32.19 32.56 32.19 31.25 30.69 

เฉลีย่ 32.60 33.06 34.68 32.66 32.79 32.19 31.52 30.73 
เฉลีย่รวม 32.52 
 
หมายเหต ุ 
จดุ A หน้าศูนย์ สหกิจศึกษา 
จดุ B ทางเดิน รวมหนึ่ง 
จดุ C ป้ายรถเมล์เรียนรวมสอง 
จดุ D ที่จอดรถรวมสอง 
จดุ E ชั้นสองรวมสองจุดตรงกัน 
จดุ F หน้าห้อง B5205 
จดุ G หน้าห้อง B5209 
จดุ H หน้าห้อง lab 5 
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ตารางที ่4.3.4 ค่าอณุหภูมทิีต่รวจจบัได้ในเวลากลางคนืทีเ่วลา 19.00 น.ในหนว่ย (องศาเซลเซยีส) 
 จดุทดสอบ 

A B C D E F G H 
ระยะทาง 
(เมตร) 

50 80 75 60 5 20 40 40 

ครัง้ที1่ 26.00 26.31 26.00 25.75 27.12 27.94 29.19 28.44 
ครัง้ที2่ 26.00 26.31 25.87 25.75 27.12 27.94 29.19 28.44 
ครัง้ที3่ 26.00 26.31 25.87 25.75 27.19 27.94 29.19 28.37 
ครัง้ที4่ 26.00 26.50 25.87 25.69 27.19 28.00 29.19 28.31 
ครัง้ที5่ 25.94 26.62 25.75 25.69 27.19 28.12 29.31 28.31 
ครัง้ที6่ 25.94 26.62 25.69 25.75 27.19 28.12 29.37 28.06 
ครัง้ที7่ 25.94 26.65 25.69 25.81 27.25 28.25 29.37 28.06 
ครัง้ที8่ 25.94 26.65 25.69 25.87 27.31 28.27 29.44 28.06 
ครัง้ที9่ 25.94 26.72 25.62 25.87 27.37 28.27 29.45 27.97 
ครัง้ที1่0 25.94 26.69 25.62 25.94 27.37 28.30 29.45 27.81 

เฉลีย่ 25.96 26.54 25.77 25.79 27.23 28.12 29.25 28.18 
เฉลีย่รวม 27.11 
 
 
 
หมายเหต ุ 
จดุ A หน้าศูนย์ สหกิจศึกษา 
จดุ B ทางเดิน รวมหนึ่ง 
จดุ C ป้ายรถเมล์เรียนรวมสอง 
จดุ D ที่จอดรถรวมสอง 
จดุ E ชั้นสองรวมสองจุดตรงกัน 
จดุ F หน้าห้อง B5205 
จดุ G หน้าห้อง B5209 
จดุ H หน้าห้อง lab 5 
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น าข้อมูลจากตารางมาพล๊อตกราฟได้ดังนี้ 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที่ 4.22 กราฟแสดงความสัมพันธ์ระหว่างอุณหภูมิเวลากลางวันกับเวลากลางคืน 
 
4.3.5  ทดสอบการท างานของเซนเซอรว์ดัอุณหภมูิของกรณ ีline-of-sight 
จะแบ่งเป็น 2 กรณีคือ 

กรณีท่ี 1 ทดสอบช่วงเวลากลางวัน ในเวลา 14.40 น. 
กรณีท่ี 2 ทดสอบช่วงเวลากลางคืน ในเวลา 20.00 น. 

 
ตารางที ่4.3.5 ค่าอณุหภูมทิีต่รวจจบัได้ในเวลากลางวนัที่เวลา 14.40 น.ในหนว่ย (องศาเซลเซยีส) 

 
ระยะทาง (เมตร) 

10 20 30 40 50 60 70 80 90 
ครัง้ที ่1 33.38 30.37 30.62 31.37 31.69 32.94 32.00 34.25 34.13 
ครัง้ที ่2 33.44 30.44 30.69 31.44 31.69 32.88 32.06 34.25 34.25 
ครัง้ที ่3 33.56 30.44 30.69 31.50 31.69 33.06 32.19 34.25 34.44 
ครัง้ที ่4 33.63 30.50 30.69 31.56 31.69 32.94 32.25 34.25 34.13 
ครัง้ที ่5 33.94 30.50 30.69 31.56 31.62 33.00 32.31 34.31 34.19 
ครัง้ที ่6 34.00 30.56 30.69 31.62 31.62 33.06 32.38 34.31 34.32 
ครัง้ที ่7 34.00 30.56 30.75 31.62 31.69 33.06 32.50 34.31 34.31 
ครัง้ที ่8 34.06 30.56 30.87 31.62 31.75 33.00 32.56 34.19 34.75 
ครัง้ที ่9 34.00 30.62 30.94 31.69 31.75 33.00 32.63 34.13 33.63 
ครัง้ที ่10 34.00 30.62 31.00 31.75 31.81 33.00 32.63 33.94 33.40 

เฉลีย่ 33.80 30.52 30.76 31.57 31.7 32.99 32.35 34.22 34.16 
เฉลีย่รวม 32.45 

ค่ า
อุณ

หภู
มิที่

รับ
ได
เ้ฉ
ลี่ย

 (อ
งศ
าเซ

ลเซี
ยส
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ตารางที ่4.3.6 ค่าอณุหภูมทิีต่รวจจบัได้ในเวลากลางคนืทีเ่วลา 20.00 น.ในหนว่ย (องศาเซลเซยีส) 

 
ระยะทาง (เมตร) 

10 20 30 40 50 60 70 80 90 
ครัง้ที ่1 26.12 25.50 25.19 25.00 24.75 26.25 24.87 24.50 24.19 
ครัง้ที ่2 26.06 25.50 25.19 25.00 24.69 26.25 24.87 24.44 24.19 
ครัง้ที ่3 26.06 25.50 25.12 25.00 24.69 26.12 24.81 24.44 24.19 
ครัง้ที ่4 26.06 25.50 25.06 24.94 24.69 26.00 24.81 24.44 24.12 
ครัง้ที ่5 26.00 25.44 25.06 24.94 24.69 25.87 24.75 24.44 24.12 
ครัง้ที ่6 26.00 25.44 25.06 24.94 24.75 25.87 24.75 24.44 24.12 
ครัง้ที ่7 25.94 25.37 25.06 24.87 24.69 25.72 24.75 24.44 24.12 
ครัง้ที ่8 25.87 25.37 25.06 24.87 25.44 25.87 24.69 24.44 24.12 
ครัง้ที ่9 25.81 25.31 25.06 24.87 25.06 25.44 24.69 24.44 24.12 
ครัง้ที ่10 25.69 25.25 25.06 24.87 25.12 25.37 24.69 24.44 24.12 

เฉลีย่ 25.96 25.42 25.09 24.93 24.86 25.88 24.77 24.45 24.14 
เฉลีย่รวม 24.61 

 
น าข้อมูลจากตารางมาพล๊อตกราฟได้ดังนี้ 
 

 
รูปที่ 4.23 กราฟแสดงความสัมพันธ์ระหว่างอุณหภูมิเวลากลางวันกับเวลากลางคืน 
 
 
 

ค่ า
อุณ

หภู
มิที่

รับ
ได
เ้ฉ
ลี่ย

 (อ
งศ
าเซ

ลเซี
ยส
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4.3.6 ทดสอบการท างานของโซลา่เซลล์  
 

 
รูปที่ 4.24 แผงโซล่าเซลล์ที่ใช้ทดสอบ 

  
การทดสอบในการชาร์จจากแผงโซล่าเซลล์แบตเตอร์รี่ เราจะท าการทดลองแบง่เป็น 2 กรณี 

คือ 1.ทดสอบชาร์จขณะที่มีความเข้มแสงน้อยหรือแสงแดดน้อย 
     2.ทดสอบการชาร์จขณะที่ความเข้าแสงมากหรือแสงแดดมาก 
ผลการทดสอบมีดังนี้ 
ตารางที ่4.3.7  ทดสอบการใช้งานโซล่าเซลล์ขณะมีแสงแดดน้อยหรือความเข้มแสงน้อย 
 

บริเวณท่ีมีแสงน้อย ครั้งที่ 1 ครั้งที่ 2 ค่าเฉลี่ย 
อุณหภูมิเริ่มต้น 26.94  27.35  27.15  

ระยะเวลาการชาร์จ 5 ชั่วโมง 5 ชั่วโมง 5 ชั่วโมง 
ระยะเวลาการใช้งาน 2 ชั่วโมง 2 ชั่วโมงครึ่ง 2.25 ชั่วโมง 

 
 
ตารางที ่4.3.8  ทดสอบการใช้งานโซล่าเซลล์ขณะมีแสงแดดมากหรือความเข้มแสงมาก  
  

บริเวณท่ีมีแสงมาก ครั้งที่ 1 ครั้งที่ 2 ค่าเฉลี่ย 
อุณหภูมิเริ่มต้น 39.67  39.13  39.40  

ระยะเวลาการชาร์จ 5 ชั่วโมง  5 ชั่วโมง 5 ชั่วโมง 
ระยะเวลาการใช้งาน 14 ชั่วโมง 15 ชั่วโมง 14 ชั่วโมงครึ่ง 
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4.4 วเิคราะหผ์ลการทดลอง 
4.4.1 วเิคราะห์การทดสอบโครงสร้างระบบการวดัอุณหภมูโิดยผ่านเครอืขา่ยไรส้าย  ZigBee 
            จาการทดสอบภายในอาคาร (อาคารเรียนรวม2) ผลจากการทดสอบตามจุดต่างๆของ
อาคาร จะเห็นได้ว่าในชั้นเดียวกันกับบริเวณที่รับและบริเวณที่ทางตรงกับจุดรับจะส่งได้ดีกว่า บริเวณ
ที่มีสิ่งกีดขวางเยอะ และในชั้นที่ 2 บริเวณท่ีใกล้กับจุดส่งก็มีค่าที่รับได้ดีกว่า บริเวณที่มีสิ่งกีดขางเยอะ
เช่นกัน แต่อย่างไรก็ตาม จากผลการทดสอบข้อมูลที่ได้รับยังมีจ านวนมาก โดยเฉลี่ยประมาณ 85 % 
ของข้อมูลที่ส่ง  
 จากการทดสอบภายนอกอาคาร (รอบๆอาคารเรียนรวม2) ผลจากการทดสอบตามจุดต่างๆ 
จะเห็นได้ว่า จุด B กับจุด C เป็นจุด 2 จุดที่อยู่ไกลที่สุดจากจุดภาครับ อาจจะเป็นเพราะมีสิ่งกีดขวาง
เป็นอาคารกับสิ่งแวดล้อมภายนอก เช่น ต้นไม้ ท าให้ส่งได้ลดลง จากผลการทดสอบข้อมูลที่ได้รับยังมี
จ านวนมาก โดยเฉลี่ยประมาณ 80 % ของข้อมูลที่ส่ง  และจุด A กับจุด D อยู่ใกล้กับภาครับมากกว่า
อีก 2 จุดท าให้ส่งข้อมูลได้เกือบ 100 %  
 จากการทดสอบภายนอกอาคาร (ทางเดินเรียนรวม2) เสมือนเป็น line-of-sight ผลจากการ
ทดสอบตามจุดต่างๆ จะเห็นได้ว่าจุดทดสอบจะเป็นลักษณะเส้นตรงและระยะห่างมากขึ้นเรื่อยๆ ผลที่
ได้คือในระยะใกล้ๆกับอุปกรณ์ทดสอบ ข้อมูลที่ได้รับมีค่าเท่ากับจ านวนข้อมูลที่ส่ง และมีค่าเท่ากัน 3 
จุดคือ A,B และ C และจุดอ่ืนๆที่ห่างออกไปก็จะเห็นได้ว่าได้รับสัญญาณน้อยลงเรื่อยๆตามล าดับซึ่ง
จากการทดสอบได้ระยะทางถึงประมาณ 90 เมตรยังสามารถรับข้อมูลได้และคาดว่ายังรับข้อมมูลได้
อีก ซึ่งจะเห็นได้ว่าค่าเฉลี่ยในการส่งแปรผกผันกับระยะทาง 
  
4.4.2 วเิคราะห์การท างานของเซนเซอรว์ดัอุณหภมูิ 

จากการทดลองได้ท าการวัดอุณหภูมิในเวลากลางวันในบริเวณอาคารเรียนรวม 2 เริ่มต้นวัด
ในเวลา 14.40 น. โดยค่าอุณหภูมิเฉลี่ยที่ได้จากการทดลองเท่ากับ 32.52 องศาเซลเซียส และจากการ
ทดลองที่ท าการวัดค่าอุณหภูมิในเวลากลางคืนได้เริ่มต้นท าการทดลองที่เวลา 19.00 น. ได้อุณหภูมิ
เฉลี่ยเท่ากับ 27.11 องศาเซลเซียส  

จากการทดลองได้ท าการวัดอุณหภูมิในเวลากลางคืนในบริเวณสนามหญ้า เริ่มต้นวัดในเวลา 
15.30 น. โดยค่าอุณหภูมิเฉลี่ยที่ได้จากการทดลองเท่ากับ 32.45 องศาเซลเซียส และจากการทดลอง
ที่ท าการวัดค่าอุณหภูมิในเวลากลางคืนได้เริ่มต้นท าการทดลองท่ีเวลา 20.00 น. ได้อุณหภูมิเฉลี่ย
เท่ากับ 24.61 องศาเซลเซียส 
 
4.4.3 วเิคราะห์การท างานของโซล่าเซลล์ 

จากผลการทดสอบการชาร์จในบริเวณที่ความเข้มแสงน้อยที่อุณหภูมิเริ่มต้นที่ 27.15 องศา
เซลเซียส โดยใช้เวลาในการชาร์จ 5 ชั่งโมง และเวลาในการใช้งาน 2.25 ชั่วโมง กับบริเวณที่มี
ความเข้มของแสงมากที่อุณหภูมิเริ่มต้นในเวลา 39.4 องศาเซลเซียส โดยใช้เวลาในการชาร์จ 5  
ชั่งโมง และเวลาในการใช้งาน 14 ชั่วโมงครึ่ง 
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4.5 สรุปผลการทดลอง 
4.5.1สรปุผลการทดสอบระบบการสง่และรับอุณหภมูโิดยผา่นเครือข่ายไรส้าย ZigBee 
  จากการทดสอบระบบการส่งและรับอุณหภูมิโดยผ่านเครือข่ายไร้สาย ZigBee เสร็จสมบูรณ์
แล้วซึ่งการทดสอบในที่นี้มีการทดสอบอยู่ 3 พ้ืนที่คือ  ภายในอาคาร ภายนอกอาคาร และภายนอก
อาคารเสมือนเป็น line-of-sight พบว่าระบบการวัดอุณหภูมิโดยผ่านเครือข่ายไร้สายที่ใช้อุปกรณ์ 
Xbee เป็นตัวส่งและรับข้อมูลระหว่างกัน เมื่อท าการทดสอบระยะทางเพ่ิมมากขึ้นท าให้การส่งและรับ
ข้อมูลระหว่าง Xbee น้อยลง ทั้งนี้ยังรวมถึงสิ่งแวดล้อมที่มีสิ่งกีดขวางและสัญญาณรบกวนที่เกิดจาก
การใช้ช่องสัญญาณเดียวกันกับ Xbee เนื่องจาก Xbee ใช้ช่องสัญญาณในย่าน 2.4 GHz ซึ่งเป็นย่าน
เดียวกันกับ wireless ของตัวอาคารของการทดสอบ แต่จากที่ท าการตรวจสอบพบว่า wireless หรือ 
SUT-Wifi มีการใช้ ช่องความที่ 1 6 และ 11 ซึ่งต่างตาก ช่องสัญญาณของ Xbee จึงได้รับผลกระทบ
สัญญาณบ้าง แต่ไม่ค่อยมีผลเท่าไร แต่ส่วนที่ผลจริงๆ ก็อย่างการ การเกิด Multipath เนื่องจากการ
ทดสอบภายในอาคาร จะเกิดการเลี้ยวเบนของคลื่น การสะท้อนของคลื่น เนื่องจาก ผนังของตัวอาคาร
นั่นเอง ซึ่งสังเกตได้จากการผลการทดลองท าให้การทดสอบภายในอาคารมีประสิทธิภาพน้อยลง 
จากการทดสอบทั้ง 3 พ้ืนที่ จะเห็นได้ว่า การทดสอบภายนอกอาคารเสมือนเป็น line-of-sight จะมี
ประสิทธิภาพการส่งได้ดีที่สุด เพราะไม่มีสิ่งกีดขวางและก็สัญญาณรบกวนภายในอาคาร 
 
4.5.2 สรปุการท างานของเซนเซอรว์ดัอุณหภมูิ 
 จากตารางที่ 4.3.3 ตารางที่ 4.3.4 ตารางที่ 4.3.5 และตารางที่ 4.3.6 จะเห็นว่าค่าอุณหภูมิ
ในตารางดังกล่าว มีค่าที่แตกต่างกันก็ออกไป ทั้งในเวลากลางวันและเวลากลางคืน ก็แสดงว่า ระบบวัด
อุณหภูมิของเรานั้นท างานได้จริง สามารถวัดอุณหภูมิได้จริง 
 
4.5.3 สรปุผลการทดลองการท างานของโซลา่เซลล์ 
 จากผลการทดสอบการชาร์จในบริเวณที่ความเข้มแสงน้อยกับบริเวณที่มีความเข้มของแสง
มากในอุณหภูมิ 39.4 จะเห็นได้ว่าบริเวณท่ีมีความเข้มแสงน้อยในอุณหภูมิ 27.15 เมื่อชาร์จในเวลาที่มี
เท่าๆกันกับบริเวณที่มีความเข้มแสงมาก จะพบว่าเมื่อชาร์จในบริเวณที่มีความเข้มแสงมาก ระยะการ
ใช้งานก็จะมาก ถ้าความเข้มแสงน้อย ระยะการใช้งานก็จะน้อยลงไปด้วย จะเห็นได้ว่าการเปรียบเทียบ 
2 อย่างนี้แปรผันตรงกัน 
 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

บทที ่ 5 
สรปุผลการทดลองและข้อเสนอแนะ 

 
5.1   บทน า  
 เนื้อหาในบทนี้เป็นการกล่าวถึงบทสรุปของโครงงานระบบตรวจวัดอุณหภูมิอัตโนมัติโดยผ่าน
เครือข่าย xbeeวัดอุณหภูมิโดยมีแหล่งจ่ายเป็นโซล่าเซลล์ซึ่งประกอบด้วยข้อสรุปของโครงงาน ปัญหา
ที่พบขณะด าเนินงาน วิธีแก้ปัญหา ตลอดจนข้อเสนอแนะและวิธีพัฒนาโครงงานต่อไป 
 
5.2   บทสรปุผลของโครงงาน 
 ระบบตรวจวัดอุณหภูมิอัตโนมัติโดยผ่านเครือข่าย xbee วัดอุณหภูมิโดยมีแหล่งจ่ายเป็นโซล่า
เซลล์ที่สร้างขึ้นในโครงงานนี้ มีส่วนประกอบหลักๆ ดังนี้ 1.) บอร์ดไมโครคอนโทรเลอร์ Aduino UNO 
R3  2.) เซ็นเซอร์วัดอุณหภูมิ Ds18b20  3.) จอ LCD 16x2  4.) วงจรแจ้งเตือน (alarm) มี
องค์ประกอบคือ รีเลย์ กับ ล าโพง โดยมีหลักการท างานคือ เมื่อท าการวัดอุณหภูมิจากตัวเซนเซอร์ที่
ภาคส่งจะส่งข้อมูลอุณหภูมิไปโดยใช้ zigbee โดยที่แหล่งจ่ายของภาคส่งคือ โซลล่าเซลล์ ในการส่ง
ข้อมูลไร้สาย และท่ีภาครับจะได้ข้อมูลที่รับได้มาแสดงผลบนจอ LCD โดยมีเงื่อนไขอยู่ว่าถ้าอุณหภูมิที่
รับได้เกินจากที่ก าหนดไว้ บอร์ด arduino UNO R3 จะท าการสั่งให้วงจรแจ้งเตือนดัง 
 การท างานโซล่าเซลล์ในบริเวณที่ความเข้มแสงน้อยกับบริเวณที่มีความเข้มของแสงมาก จะ
เห็นได้ว่าบริเวณท่ีมีความเข้มแสงน้อยเมื่อชาร์จในเวลาที่มีเท่าๆกันกับบริเวณที่มีความเข้มแสงมาก จะ
พบว่าเมื่อชาร์จในบริเวณที่มีความเข้มแสงมาก ระยะการใช้งานก็จะมาก ถ้าความเข้มแสงน้อย ระยะ
การใช้งานก็จะน้อยลงไปด้วย 
 
5.3  ปญัหาและอปุสรรค 
 

ปัญหาและอปุสรรค วธิแีกไ้ข 
1.   ระยะทางในการวัด Xbee มีข้อจ ากัด 1.   จากการศึกษาข้อมูลพบว่าระยะทางที่

สามรถวัดได้สามารถวัดได้ถึงประมาณ 90 
เมตร ก็วัดตามสเปคของ Xbee 

2.การชาร์จเตอร์รี่ไม่เข้า 2.   ท าให้ศักย์จองโซล่าเซลล์สูงกว่า
แบตเตอร์รี่จึงท าให้ชาร์จเข้า 

3.สภาพอากาศในการชาร์จแบตเตอร์รี่จาก 
แผงโซล่าเซลล์ 

3.รอสภาพอากาศในวันที่แสงแดดแรง มันจะ
ท าให้มีความเข้มแสงในการชาร์จได้สูง 

4.  แบตเตอร์รี่ที่ใช้ในการส่งเข้าบอร์ด ardiono ไม่
พอจากตอนแรกใช้แบตเตอร์รี่ 3.7 v 1000mAh 4
ก้อน 

4.   เพ่ิมขนาดความจุของแบตเตอร์รี่เป็น 
7.2 Ah และขนาดของแรงดันเป็น 12 V 
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5. ก าลังของแผงโซลล่าเซลล์ที่ใช้ในการทดลองตอน
แรกมีค่าน้อย 

5.เปลี่ยนแผงโซล่าเซลล์ให้มีขนาดก าลังงาน
ให้มีค่าสูงขึ้นจากตอนแรก จาก 1w เป็น 
10w เพ่ือใช้ในการชาร์จแบตเตอร์รี่ที่เร็วขึ้น 
และมีขนาดใหญ่ขึ้น 

5.4  ข้อเสนอแนะ 
1. ถ้าต้องการให้ได้ค่าก าลังงานในการชาร์จเร็วขึ้น ก็เพ่ืมขนาดก าลังงานของแผงโซล่าเซลล์ 
2. สามารถเพ่ิม Function ให้กับเซนเซอร์ได้มากขึ้นอีก หรือเปลี่ยนเป็นเซนเซอร์ที่มีคุณภาพ

ยิ่งขึ้นแต่ราคาก็สูงขึ้นด้วย 
3. สามารถเพ่ิม Function ในการแจ้งเตือนได้อีก เช่น เพ่ิมไฟ LED หรือวงจรเสียงที่มีเสียงดังขึ้น 
4. สามารถเขียนโปรแกรมให้จอ LCD Freeze ค่าสูงสุดไว้เพื่อสะดวกต่อการอ่านค่า 
5. สามารถเปลี่ยนตัวส่งและตัวรับข้อมูลไร้สาย (zigbee) ให้มีสายกาอาศท่ีมีก าลังงานส่งได้ 
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[2] Xbee [ออนไลน์] เข้าถึงได้จาก:  http://www.thaieasyelec.com/Review-Product-Article/step-by-
step-to-use-xbee-from-digi.html และ  http://wara.com/article-736.html 

[3] เซนเซอร์ DS18B20 [ออนไลน์] เข้าถึงได้จาก: 
http://www.hobbyist.co.nz/?q=temperature_sensor_ds18b20 

[4] Code เซนเซอร์ DS18B20 [ออนไลน์] เข้าถึงได้จาก:  
http://www.ee.kmutnb.ac.th/eerobot/esl/learning/index.php?article=ds18b20-temperature-
sensor 

[5] Code Arduino [ออนไลน์] เข้าถึงได้จาก: http://www.arduino.cc/ 
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ประวตัิผู้เขยีน 
 

 นาย สุภนยั กระจายศรี เกิดเม่ือวนัท่ี 8 เมษายน พ.ศ.2536 ภูมิล าเนา
อยู่ท่ี 46/7 ซ.พิมพา ต.เขาสามยอด อ.เมืองลพบุรี จงัหวดัลพบุรี 
ส าเร็จการศึกษาระดบัมธัยมตอนปลายจากโรงเรียนพระนารายณ์  
อ.เมือง จงัหวดัลพบุรี ปัจจุบนัเป็นนกัศึกษาชั้นปีท่ี 4 สาขาวิศวกรรม
โทรคมนาคม ส านกัวิชาวิศวกรรมศาสตร์ มหาวิทยาลยัเทคโนโลยี
สุรนารี จงัหวดันครราชสีมา 

 
 
นาย ศณัฐขะพล อตัตวนิช เกิดเม่ือวนัท่ี 5 สิงหาคม พ.ศ.2536 
ภูมิล าเนาอยู่ท่ี 2/237 หมู่ 13 ต.คลองหน่ึง อ.คลองหลวง จงัหวดั
ปทุมธานี ส าเร็จการศึกษาระดับมัธยมตอนปลายจากโรงเรียน
ธรรมศาสตร์คลองหลวงวิทยาคม อ.คลองหลวง จงัหวดัปทุมธานี 
ปัจจุบนัเป็นนกัศึกษาชั้นปีท่ี 4 สาขาวิศวกรรมโทรคมนาคม ส านกั
วิชาวิศวกรรมศาสตร์ มหาวิทยาลัยเทคโนโลยีสุรนารี จังหวัด
นครราชสีมา 
 

 
 

นายกฤษฎา กลีบจ าปา  เ กิดเ ม่ือว ันท่ี  20 มกราคม พ.ศ.2536 
ภูมิล าเนาอยูท่ี่ 63 หมู่ 3 ต.พิกุลทอง อ.ท่าชา้ง จงัหวดัสิงห์บุรี ส าเร็จ
การศึกษาระดบัมธัยมตอนปลายจากโรงเรียนพิบูลวทิยาลยัลพบุรี  
อ.เมือง จงัหวดัลพบุรี ปัจจุบนัเป็นนกัศึกษาชั้นปีท่ี 4 สาขาวศิวกรรม
โทรคมนาคม ส านกัวิชาวิศวกรรมศาสตร์ มหาวิทยาลยัเทคโนโลยี
สุรนารี จงัหวดันครราชสีมา 
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ภาคผนวก 

ภาคผนวก ก 

 

 

 

 

 

 

 

 

 

รูปอุปกรณ์ภาคส่ง 

 

 

 

 

 

 

 

 

 

รูปอุปกรณ์ภาครับ 
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ภาคผนวก ข 

เซนเซอร์อุณหภูมิ Dsb1820
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